


Από σαράντα κύματα χρειάστηκε να πε-

ράσει η υπεύθυνη ομάδα του περιοδικού για να

ετοιμάσει το πολυαναμενόμενο τεύχος 1 4! Όλοι

όσοι συμμετέχουμε στην προετοιμασία κάθε τεύ-

χους Ubuntistas είμαστε εθελοντές και το κάνου-

με στον ελεύθερο μας χρόνο, το κάνουμε γιατί

μας αρέσει και γιατί είναι εξαιρετικά σημαντικό

το να προσφέρεις πίσω στην κοινότητα. Δυστυ-

χώς όμως με τα δεδομένα της εποχής, τα προβλή-

ματα και οι εκκρεμότητες πληθαίνουν όλο ένα

και περισσότερο στις ζωές μας με αποτέλεσμα

κάποιοι να αδυνατούν να συμμετέχουν.

Όλο αυτό το διάστημα που πέρασε από

την κυκλοφορία του προηγούμενου τεύχους

υπήρξαν πάμπολλες φορές που ο ένας περίμενε

τον άλλον στην ομάδα και κάπως έτσι το παρόν

τεύχος καθυστερούσε. Ήταν μια πολύ μεγάλη...

μπόρα που ελπίζουμε να πέρασε, ειδικά μετά την

ριζική ανανέωση της ομάδας και τους νέους εθε-

λοντές που έχουμε κοντά μας.

Η αλήθεια είναι ότι χρειαζόμαστε ενίσχυ-

ση στο κομμάτι της σελιδοποίησης, θέλουμε ένα

δύο άτομα ακόμα που να γνωρίζουν καλά το

πρόγραμμα Scribus. Μην διστάσετε να επικοινω-

νήσετε μαζί μας αν θελήσετε να συμμετέχετε

στην δημιουργία του περιοδικού Ubuntistas! Για

περισσότερες λεπτομέρειες, απορίες ή διευκρι-

νήσεις δείτε το σχετικό θέμα στο φόρουμ

http://goo.gl/EZzHP. Επίσης μπορείτε να επικοι-

νωνήσετε μαζί μας στέλνοντας μήνυμα στο

info@ubuntistas.gr.

Διαβάζοντας το τεύχος 1 4 θα βρείτε μετα-

ξύ άλλων άρθρα για την εισαγωγή στην σελιδο-

ποίηση με το Scribus, παρουσίαση της διανομής

DoudouLinux και των δημοφιλέστερων πλοηγών

διαδικτύου. Επίσης στο παρόν τεύχος θα δια-

βάσετε συνέντευξη με τον Κωνσταντίνο Καναβό

και θα ενημερωθείτε σχετικά με την επισκευή

boot. Και τέλος οι λάτρεις του προγραμματισμού

και όχι μόνο, στο τεύχος αυτό θα βρουν το δεύ-

τερο μέρος από τον προγραμματισμό κελύφους

κι ένα άρθρο για τη νέα έκδοση 7 της Java.

Καλή ανάγνωση!
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To ubuntu
Το ubuntu linux είναι ένα λειτουργικό σύστημα. Με
περιβάλλον εργασίας gnome το φωνάζουμε ubuntu,
με kde το φωνάζουμε kubuntu. Είναι πλήρες(!), τεχνο­
λογικά προηγμένο(!), και εύκολο στην χρήση από οποι­
ονδήποτε(!). Στα αποθετήρια του ubuntu υπάρχουν
διαθέσιμες κυριολεκτικά χιλιάδες εφαρμογές σχεδόν για
οτιδήποτε(!) … για επαγγελματική, επιστημονική, εκ­
παιδευτική, και οικιακή χρήση. Τόσο το ubuntu όσο και
οι εφαρμογές του είναι Ελεύθερο Λογισμικό / Λογισμικό
Ανοιχτού Κώδικα (ΕΛ/ΛΑΚ), δηλαδή διατίθενται ελεύ­
θερα, και στην Ελλάδα υποστηρίζονται από την άτυπη
αλλά πολύ δραστήρια κοινότητα ubuntu­gr. Περισσό­
τερα στο http://www.ubuntu­gr.org.Η κοινότητα ubuntu­gr
Η κοινότητα ubuntu­gr ανήκει στα μέλη της και είναι
ανοιχτή σε όλους! Eίναι το μέρος όπου έμπειροι και ά­
πειροι(!) χρήστες συζητάνε ό,τι τους απασχολεί, ιδέες,
ερωτήματα, πρακτικά ζητήματα, οργανωτικά θέματα,
και κυρίως τεχνικά προβλήματα. Αποτελείται από αν­
θρώπους με εμπειρία στην πληροφορική αλλά κυρίως
από απλούς χρήστες, οι οποίοι εθελοντικά συμμετέ­
χουν i) στην δημιουργία­ανάπτυξη του λογισμικού, ii)
στην μετάφρασή του στην ελληνική γλώσσα, iii) στην
προώθηση­διάδοση του στην Ελλάδα, και κυρίως iv)
στην παροχή αμεσότατης(!) και υψηλής ποιότητας(!)
τεχνικής υποστήριξης σε άλλους ελληνόφωνους χρή­
στες. Λειτουργεί με αυτό­οργάνωση και προσπαθούμε
οι αποφάσεις να λαμβάνονται όσο το δυνατόν πιο δημο­
κρατικά από εκείνους που προσφέρουν­δραστηριοποι­
ούνται συστηματικά. Η ελληνική κοινότητα του Ubuntu
διαθέτει μέχρι στιγμής φόρουμ, λίστα ηλ. ταχυδρομείου,
κανάλι συζητήσεων τύπου IRC, καθώς και το περιοδικό
Ubuntistas. Για όλα αυτά υπάρχουν οδηγίες και links
στο http://www.ubuntu­gr.org.Το περιοδικό ubuntistas
Το Ubuntistas, το ηλεκτρονικό περιοδικό της ελληνικής
κοινότητας του ubuntu (ubuntu­gr), κυκλοφορεί ελεύ­
θερα κάθε δίμηνο, με πρώτο τεύχος του Νοεμβρίου ­
Δεκεμβρίου 2008. Περιέχει νέα, πληροφορίες, συνεντεύ­
ξεις, παρουσιάσεις, οδηγούς, και άρθρα σχετικά με το
ubuntu. Το περιοδικό είναι ανοιχτό σε όλους, όπως
και το GNU/Linux! Ο καθένας μπορεί να συμμετέχει
ενεργά στην δημιουργία του, να αρθρογραφήσει, να
προτείνει ιδέες και να κάνει τις επισημάνσεις / παρατη­
ρήσεις του

Η άδεια διάθεσης του περιεχομένου του ubuntistas
Τα άρθρα που περιλαμβάνονται στο περιοδικό διατίθενται υπό τη άδεια της Creative Commons Attribution­By­Share Alike
3.0 Unported license. Αυτό σημαίνει ότι μπορείτε να προσαρμόσετε, να αντιγράψετε, να διανείμετε και να διαβιβάσετε τα
άρθρα, αλλά μόνο υπό τους ακόλουθους όρους: πρέπει να αποδώσετε την εργασία στον αρχικό συντάκτη (π.χ. με
αναφορά ονόματος, email, url) αλλά και στο περιοδικό, αναφέροντας την ονομασία του (Ubuntistas). Δεν επιτρέπεται να
αποδίδετε το άρθρο/α με τρόπο που να το/α επικυρώνετε ως δική σας εργασία. Και εάν κάνετε αλλαγές, μεταβολές, ή
δημιουργίες πάνω σε αυτήν την εργασία, πρέπει να διανείμετε την
προκύπτουσα εργασία με την ίδια άδεια, παρόμοια ή συμβατή.
Περίληψη άδειας: http://tinyurl.com/5nv7kn ­ Πλήρης άδεια: http://tinyurl.com/yqontc
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ΚΟΙΝΟΤΗΤΑ

Μεταφραστικές συναντήσεις της Ελληνικής κοινότητας
Ubuntu-gr

Συνάντηση στο Θησείο

Την Κυριακή 1 3 Νοεμβρίου 201 1 πραγματοποιήθηκε
συνάντηση στο καφέ Ηλιοστάσιο στην περιοχή του
Θησείου, με θέμα τη μετάφραση των διανομών
του Ubuntu. O σκοπός της συνάντησης αυτής
ήταν μάθουμε τον τρόπο με τον οποίο γίνονται
οι μεταφράσεις, τα εργαλεία που χρειάζεται
κάποιος για να μεταφράσει κάποιο πακέτο, την
διαδικασία μέχρι να φτάσει μια μετάφραση
στον υπολογιστή μας και κυρίως το πως μπορεί
ο καθένας από εμάς να βοηθήσει στο μεταφρα-
στικό έργο. Αν και η συνάντηση είχε οριστεί για
το μεσημέρι στις 1 4:00, σε μία λίγο βροχερή μέρα
και με αρκετές κυκλοφοριακές ρυθμίσεις στην Ατ-
τική λόγω του 29ου κλασικού μαραθωνίου Αθηνών,
η συμμετοχή των μελών της κοινότητάς μας ήταν ικα-
νοποιητική.

Λίγο μετά τις 1 4:30 και ενώ είχαν μαζευτεί αρκετά άτομα, συν-
δέθηκε ένας φορητός υπολογιστής στην οθόνη της καφετέριας
και άρχισε μία εισαγωγική συζήτηση - ενημέρωση γύρω από τις με-
ταφράσεις. Η συζήτηση ξεκίνησε με το σύνθημα ότι όλοι μπορούν
να συνεισφέρουν στις μεταφράσεις, ο καθένας με τον τρόπο του
και τις γνώσεις του. Από την πρώτη στιγμή της συζήτησης, φάνηκε
ότι δεν χρειάζεται απαραίτητα να ξέρει κάποιος καλά (ή ακόμη και
καθόλου) Αγγλικά για να βοηθήσει στο μεταφραστικό έργο, μπο-
ρεί ακόμη και εκείνος βλέποντας τη μετάφραση στα Ελληνικά να

εντοπίσει ορθογραφικά λάθη, λάθος τονισμένες λέξεις ή ακόμη
και προτάσεις οι οποίες δεν βγάζουν νόημα! Το επόμενο σκέλος
της συνάντησης αφορούσε το που και πως γίνονται οι μετα-
φράσεις. Στο σημείο αυτό έγινε αναφορά - παρουσίαση του
Launchpad, το οποίο, εκτός από τις αναφορές σφαλμάτων, συγκε-
ντρώνει και τα πακέτα που μπορεί κάποιος να μεταφράσει για

κάθε έκδοση. Η μετάφραση εδώ γίνεται online με μεγάλη
ευκολία χωρίς να απαιτούνται γνώσεις και ρυθμίσεις
σε κάποιο μεταφραστικό πρόγραμμα. Έγινε επίδειξη
μετάφρασης μερικών μηνυμάτων ενός πακέτου
μέσω του Launchpad και μάθαμε όλοι οι παρευ-
ρισκόμενοι πως να χρησιμοποιούμε το
Launchpad για τις μεταφράσεις μας.

Με το τέλος της συνάντησης, τέθηκε ως
στόχος το να ξεκινήσει η μετάφραση του πα-
κέτου βοήθειας “ubuntu-help” (yelp) του
Ubuntu, με σκοπό να εξοικειωθούν όσοι θα δο-
κίμαζαν να μεταφράσουν για πρώτη φορά. Όλοι
έφυγαν με την προσδοκία και την θέληση να συ-

νεισφέρουν ώστε να μεταφραστεί πλήρως στα Ελ-
ληνικά η επερχόμενη έκδοση Ubuntu 1 2.04 και η

αρχή μόλις είχε γίνει...!

Συνάντησεις στο IRC

Σε συνέχεια της συνάντησης στο Θησείο, πραγματοποιήθηκε μία
συνάντηση στις 1 7 Νοεμβρίου 201 1 μέσω IRC στο κανάλι της κοι-
νότητας, με σκοπό να προχωρήσει η μετάφραση του πακέτου πα-
κέτου βοήθειας “ubuntu-help” (yelp) [1 ] , να γίνει γνωστή η
διαδικασία μετάφρασης και σε μέλη που είναι εκτός Αθηνών ή
που λόγω υποχρεώσεων, δεν κατάφεραν να παρευρεθούν στο

τουΓιώργουΧριστοφή

Δραστηριότητες της Ελληνικής Κοινότητας Ubuntu
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Θησείο στις 1 3 Νοεμβρίου. Στις 22:00 το βράδυ συναντήθηκαν πε-
ρίπου 20 άτομα και ξεκίνησε η μετάφραση του πακέτου, ενώ πα-
ράλληλα λύνονταν και απορίες που προέκυπταν, όπως επίσης
δίνονταν και οδηγίες για την καλύτερη και αποτελεσματικότερη με-
τάφραση.

Όταν ξεκίνησε η «μαζική μετάφραση» το πακέτο βρισκόταν με-
ταφρασμένο σε ποσοστό 7% και μέσα σε μόλις περίπου 2 ώρες εί-
χε φτάσει στο 1 4%! Από τη συνάντηση αυτή και μετά συνεχίστηκε
η μετάφραση και σε άλλα πακέτα, με έμφαση όμως στο “ubuntu-
help”. Για την ιστορία το πακέτο με το οποίο ξεκινήσαμε έφτασε
στο 1 00% σχεδόν ένα μήνα μετά, στις 1 9 Δεκεμβρίου, όταν μετα-
φράστηκαν τα 2644 μηνύματα του πακέτου, από τα συνολικά 26
άτομα που συνετέλεσαν στη μετάφραση αυτή.

Στις 1 9 Ιανουαρίου πραγματοποιήθηκε νέα συνάντηση μέσω IRC
στο κανάλι της κοινότητας, με βασικό στόχο αυτή τη φορά, τα πα-
κέτα app-install-data [2] , deja-dup [3] και checkbox [4] .

Ξεκινώντας τη μετάφραση των πακέτων αυτών, τα βασικά πακέτα
για την έκδοση 1 2.04 ήταν μεταφρασμένα σε ποσοστό 92%, κατατάσ-
σοντας την Ελληνική έκδοση στη 1 7η θέση παγκοσμίως, σύμφωνα με
τα στατιστικά στοιχεία της Canonical. Μέσα σε λίγες ώρες, μετα-
φράστηκαν περίπου 450 μηνύματα, με αποτέλεσμα τα πακέτα app-
install-data [2] και deja-dup [3] να μεταφραστούν στο ακέραιο, ενώ
το πακέτο checkbox [4] ολοκληρώθηκε λίγες μέρες μετά. Επόμενα βή-
ματα του μεταφραστικού έργου της κοινότητας ήταν να μεταφρα-
στούν τα πακέτα kdeqt, gnome-settings-daemon, pulseaudio,
rhythmbox, evolution-data-server, gnome-system-monitor, gnome-
keyring, gtk-3.0-properties, empathy, vinagre και άλλων, από τη λί-
στα με τα βασικά πακέτα [5] για την 1 2.04, καταφέρνοντας έτσι το
Ubuntu 1 2.04 να «μιλά» Ελληνικά σε ποσοστό 1 00%! Αυτή τη στιγμή
το ποσοστό «εξελληνισμού» του Ubuntu 1 2.04 κυμαίνεται από 98
έως 1 00% και εξαρτάται από τα νέα αμετάφραστα πακέτα ή τις προ-
σθήκες νέων μηνυμάτων σε ήδη μεταφρασμένα πακέτα. Η λίστα με
τα βασικά πακέτα ανανεώνεται συνεχώς και προστίθενται νέα πα-
κέτα, οπότε το μεταφραστικό έργο της κοινότητας [6] δεν σταματά...,

πάντα θα υπάρχει κάποιο μήνυμα για μετάφραση!

[1]https://translations.launchpad.net/ubuntu-docs/oneiric/+pots/ubuntu-

help/el/+translate

[2]https://translations.launchpad.net/ubuntu/precise/+source/app-install-data-

ubuntu/+pots/app-install-data/el/+translate

[3]https://translations.launchpad.net/ubuntu/precise/+source/deja-

dup/+pots/deja-dup/el/+translate

[4]https://translations.launchpad.net/ubuntu/precise/+source/checkbox/+pots/ch

eckbox/el/+translate

[5]Στατιστικά μετάφρασηςγια την12.04:

http://people.canonical.com/~dpm/stats/ubuntu-12.04-translation-stats.html

[6]Μεταφραστικό έργο κοινότηταςγια την12.04:

http://forum.ubuntu-gr.org/viewtopic.php?f=36&t=21945

Ubuntu Global Jam στην Αθήνα

Στα πλαίσια του Ubuntu Global Jam [1 ] , η Eλληνική κοινότητα
Ubuntu-gr διοργάνωσε συνάντηση παράλληλα με άλλες κοινότη-
τες του κόσμου. Η ελληνική συνάντηση πραγματοποιήθηκε στις 4
Μαρτίου στο Hackerspace.gr στην Αθήνα. Τα βασικά θέματα της
συνάντησης ήταν θέματα τεκμηρίωσης (Ubuntu Desktop Guide),
μεταφράσεις πακέτων και δοκιμές του λειτουργικού. Στη συ-
νάντηση παρευρέθηκαν αρκετά μέλη της κοινότητας και φίλοι του
Ubuntu, δημιουργώντας ένα όμορφο κλίμα με την παρουσία τους
και τις εποικοδομητικές συζητήσεις όπου συμμετείχαν. Μέρος της
συνάντησης μεταδόθηκε σε live streaming [2] , ενώ πάρθηκαν και
μερικές φωτογραφίες [3] .

[1]Ubuntu Global Jam: http://loco.ubuntu.com/events/global/1443/detail/

[2]Βίντεο συνάντησης: http://www.ustream.tv/recorded/20873776

http://www.ustream.tv/recorded/20873868

http://www.ustream.tv/recorded/20873961

[3]Φωτογραφίεςσυνάντησης : http://tinyurl.com/75vr69y

https://translations.launchpad.net/ubuntu-docs/oneiric/+pots/ubuntu-help/el/+translate
https://translations.launchpad.net/ubuntu/precise/+source/app-install-data-ubuntu/+pots/app-install-data/el/+translate
https://translations.launchpad.net/ubuntu/precise/+source/deja-dup/+pots/deja-dup/el/+translate
https://translations.launchpad.net/ubuntu/precise/+source/checkbox/+pots/checkbox/el/+translate
http://people.canonical.com/~dpm/stats/ubuntu-12.04-translation-stats.html
http://forum.ubuntu-gr.org/viewtopic.php?f=36&t=21945
http://loco.ubuntu.com/events/global/1443/detail/
http://www.ustream.tv/recorded/20873776
http://www.ustream.tv/recorded/20873868
http://www.ustream.tv/recorded/20873961
https://www.ubuntu-gr.org/content/ubuntu-global-jam-%CE%B1%CE%B8%CE%AE%CE%BD%CE%B1-32012
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ΕΠΙΚΑΙΡΟΤΗΤΑ
Η Ελλάδα ψήφισε το νόμο ACTA

Το Internet μπορεί να πάψει να υπάρχει όπως το γνωρίζαμε
μέχρι σήμερα καθώς 22 κράτη μέλη της Ευρωπαϊκής Ένωσης -
ανάμεσα τους και η χώρα μας - υπέγραψαν στις 26
Ιανουαρίου 201 2 στο Τόκυο τη συμφωνία κατά
της πειρατείας ACTA (Anti-Coutnerfeiting
Trade Agreement), με τις διαπραγματεύσεις
να πραγματοποιούνται χωρίς δημόσιες δια-
βουλεύσεις - σχεδόν στα κρυφά. Το “Σύμφω-
νο ενάντια στην ανταλλαγή πλαστών
προϊόντων” αφορά τη θέσπιση διεθνών προτύ-
πων σε ζητήματα που σχετίζονται με την προ-
στασία και την επιβολή των πνευματικών
δικαιωμάτων και την καταπολέμηση της πει-
ρατείας. Μεταξύ άλλων, η συμφωνία προτείνει
σοβαρότατες κυρώσεις (όπως απαγόρευση
πρόσβασης στο διαδίκτυο, πρόστιμα ή ακόμα
και φυλάκιση), για όσους επιχειρήσουν να χρη-
σιμοποιήσουν ή/και να μοιραστούν  αρχεία προ-
στατευμένα με copyright.

Η υπογραφή της συμφωνίας έχει προκαλέσει
έντονες αντιδράσεις στην Ευρώπη με χιλιάδες
οργανώσεις, ακτιβιστές αλλά και απλούς πολίτες,
να κατηγορούν το ACTA για κατάργηση της ελευθε-
ρίας της έκφρασης στο διαδίκτυο. Ειδικότερα στην Πολω-
νία, η κατάσταση δείχνει να έχει ξεφύγει εκτός ελέγχου. Από την
1 η Οκτωβρίου 201 1 τη συμφωνία έχουν υπογράψει και οι ΗΠΑ,
Αυστραλία, Καναδάς, Νότια Κορέα, Σιγκαπούρη, Νέα Ζηλανδία και
Μαρόκο. Οι πέντε ευρωπαϊκές χώρες που δεν υπέγραψαν είναι οι
Γερμανία, Ολλανδία, Εσθονία, Σλοβακία και Κύπρος. Για τις συ-
νέπειες αυτού του νόμου, μπορείτε να δείτε το κατανοητό και με
ελληνικούς υπότιτλους βίντεο των Anonymous:
http://www.youtube.com/watch?v=UXsmEbekjmw, ενώ μπορείτε
να κατεβάσετε το νόμο στα ελληνικά από εδώ:

http://register.consilium.europa.eu/pdf/el/1 1 /st1 2/st1 21 96.el1
1 .pdf.

Πώς μπορούμε ν' αντιδράσουμε; Υπογράφοντας εδώ:
https://secure.avaaz.org/en/eu_save_the_internet/?cl=1 53876201
0&v=1 2283 προτού υπογραφεί από το ευρωκοινοβούλιο.

EPFSUG – European Parliament Free Software User Group
Πρόκειται για μια ανοιχτή κοινότητα αποτελούμενη από

υπαλλήλους του Ευρωκοινοβουλίου, η οποία έχει σαν

σκοπό την προώθηση του ανοικτού λογισμικού στο

ευρωκοινοβούλιο αλλά και γενικότερα σε όσους εν-

διαφέρονται για το ανοικτό λογισμικό, καθώς επί-

σης και την προώθηση ανοικτών προτύπων για

το καλό της Ευρωπαϊκής οικογένειας. Ήδη δια-

θέτει πέντε λίστες ηλεκτρονικού ταχυδρομείου

epfsug-subscribe@epfsug.eu, έναν IMAP εξυ-

πηρέτη Η/Τ tmail, μια υπηρεσία συνεργατικής

επεξεργασίας κειμένου http://pad.epfsug.eu και

κανάλι IRC irc.oftc.net #epfsug. Για περισσότε-

ρες πληροφορίες επισκεφθείτε την ιστοσελίδα

τους:http://epfsug.eu/.

Ευρωπαϊκό Ίδρυμα Ελεύθερου Λογισμικού –
FSFE

Το Ευρωπαϊκό Ίδρυμα Ελεύθερου Λογισμικού είναι μια μη κερ-
δοσκοπική οργάνωση αφιερωμένη στην πρόοδο του Ελεύθερου
Λογισμικού, η οποία εργάζεται για να προωθήσει την ελευθερία
στην αναδυόμενη ψηφιακή κοινωνία. Για περισσότερες πληροφο-
ρίες ανατρέξτε στην ιστοσελίδα τους: http://fsfe.org/, ενώ στο
wiki: http://wiki.fsfe.org μπορείτε να βρείτε αρκετές χρήσιμες
πληροφορίες όπως π.χ. για το πως να τρέξετε αποκλειστικά λογι-
σμικό ανοικτού κώδικα στο Android σας:
http://wiki.fsfe.org/Android.

τουΓιάννη Κωστάρα

http://www.youtube.com/watch?v=UXsmEbekjmw
http://register.consilium.europa.eu/pdf/el/11/st12/st12196.el11.pdf.
https://secure.avaaz.org/en/eu_save_the_internet/?cl=1538762010&v=12283
http://wiki.fsfe.org/Android
http://epfsug.eu/
http://pad.epfsug.eu
http://fsfe.org/
http://wiki.fsfe.org/
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FOSDEM 4-5 Φεβρουαρίου 201 2

Άλλη μια γιορτή του ελεύθερου λογισμικού έλαβε χώρα στις 4-5
Φεβρουαρίου στους χώρους του πανεπιστημίου Universite Libre
de Bruxelles (ULB). Το Free and Open Source Developers
European Meeting είναι το μεγαλύτερο γεγονός που οργανώνεται
από και για την κοινότητα ελεύθερου λογισμικού. Στόχος του είναι
να παρέχει ένα χώρο συνάντησης στους προγραμματιστές ελεύθε-
ρου λογισμικού. Με πολύ πλούσιο πρόγραμμα, και με θερμοκρασί-
ες υπό το μηδέν, διατέθηκαν νέα κτίρια για να μπορέσουν να
φιλοξενήσουν το πλήθος κόσμου. Υπήρξε πληθώρα θεματικών
ενοτήτων που ευτυχώς είχαν οργανωθεί έτσι ώστε να συμβαίνουν
στην ίδια αίθουσα ώστε να αποφεύγονται οι άσκοπες μετακινή-
σεις. Έτσι, θα μπορούσατε να περάσετε όλη τη μέρα σας σε μια αί-
θουσα ακούγοντας μόνο για Java, Android, Ruby, KDE,
LibreOffice, JBoss, XMPP, Ada, MySQL, Postgresql, Asterisk,
Firefox, για τον πυρήνα του Linux, ασφάλεια, και για άλλα πολλά.
Επίσης υπήρχε η δυνατότητα για όσους ήθελαν, να δοκιμάσουν τις
γνώσεις τους δίνοντας εξετάσεις πιστοποίησης LPI ή BSDA. Επι-
πλέον έχουν αρχίσει και διατίθενται κάποια video που αφορούν
την διοργάνωση. Για περισσότερες πληροφορίες, ανατρέξτε στην
ιστοσελίδα: http://www.fosdem.org/201 2/.

http://www.fosdem.org/2012/
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-Κωνσταντίνε, χαρά μας που σε έχουμε στο Ubuntistas! Πες μας
λίγα λόγια για σένα, την μόρφωση και την σχέση σου με την τε-
χνολογία.

Ξεκίνησα με εντελώς άσχετα με τη τεχνολογία θέματα, έχοντας
σπουδάσει αρχιτεκτονική εσωτερικών χώρων και εμποροπλοίαρ-
χος. Ήταν οι δυο μεγάλες μου λόξες!
Βέβαια από πολύ μικρός, είχα κονσόλες-παιχνιδομηχανές της επο-
χής και στη συνέχεια ένα σωρό χρήσιμα η άχρηστα γκατζετάκια.
Επόμενο ήταν λοιπόν, να έρθει σύντομα και ο πρώτος υπολογι-
στής, με Unix τότε και αργότερα με DOS.

-Πώς και πότε προέκυψε η ιδέα για το OSArena;

Όλα άρχισαν από ένα προσωπικό μπλογκ το YAGLB, το οποίο ξε-
κίνησα, πριν τριάμισι σχεδόν χρόνια, όταν αποφάσισα να μετακομί-
σω από την Αθήνα στην επαρχία.
Στην αρχή το έκανα για έμενα και φίλους, γνωστούς, συγγενείς, συ-
νάδελφους που τους είχα μυήσει στο Linux. Στη πορεία όμως είδα
πως η σελίδα είχε επισκεψιμότητα που με παραξένεψε πολύ. Έτσι
άρχισα να δημιουργώ πιο προσεγμένα άρθρα.

Αυτό ήρθε σε μια εποχή, όπου κατά γενική παραδοχή τα
φόρουμ αργοπέθαιναν, ίσως λόγω της δομής τους και της όχι και
τόσο εύκολης εύρεσης της πληροφορίας, μα κατά κύριο λόγο, εξαι-
τίας της έλευσης των social media, όπου ο λόγος ήταν πιο λιτός.

Έβλεπα όμως πως ο κόσμος είχε αρχίσει να μαθαίνει για το
Linux και να διψάει για κάτι περισσότερο. Συγχρόνως από τα
σχόλια στο τότε μπλογκ, μα και από προσωπικές επαφές κατάλα-
βα πως δεν είναι όλοι αγγλομαθείς και ότι αν και υπήρχαν ελληνι-
κές σελίδες του χώρου μας, με δυνατά άρθρα, εν τούτοις ήταν
διάσπαρτες. Το ερέθισμα όμως ήρθε από κάποιο σχόλιο, ρατσιστι-

κό κατά την γνώμη μου, στο OMG Ubuntu, όπου χαρακτήριζε τους
Έλληνες, ανόητους και χαμηλού επιπέδου, χωρίς τη παραμικρή
γνώση τεχνολογίας. Αντί να απαντήσω στο εν λόγω σχόλιο και να
δημιουργηθεί flame και λόγω της άρνησης του ιδιοκτήτη της σελί-
δας να διαγράψει το επίμαχο κακεντρεχές άρθρο, ήρθε η ιδέα για
κάτι μεγάλο και ελληνικό.
Δύσκολο βέβαια, καθώς σαν λαός, η αλήθεια είναι ότι δεν συνερ-
γαζόμαστε και προτιμά ο καθένας να κάνει το δικό του.

Ήταν και η εποχή που το Android είχε αρχίσει να ανεβαίνει και
έτσι η πρώτη επαφή ήταν με τον Αλέξανδρο Μίττο που είχε δη-
μιουργήσει το Magneblog το οποίο ασχολούνταν αποκλειστικά με
Android. Έγιναν προτάσεις και σε άλλους μπλόγκερ η ανθρώπους
που γνώριζα από το παλιό φόρουμ του LinuxFormat και κάπως
έτσι ξεκίνησε. Το πιο εντυπωσιακό ήταν πως στα πρώτα 3 λεπτά
που βγήκε το OSArena στον αέρα, δέχθηκε αμέσως πάνω από
4.000 επισκέψεις!

Συνέντευξη με τον Κωσταντίνο από το OSArena. net τουΦίλιππουΦωτιάδη
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-Πως θα ήθελες να δεις να εξελίσσεται το ΟSArena στο μέλλον;

Σίγουρα τα θέλω των ανθρώπων, απέχουν παρασάγγες, από αυ-
τό που γίνεται στη πραγματικότητα. Υπάρχει η σκέψη με τα ads
που προσθέσαμε, να γίνει ένα ας πούμε OSArena Foundation και
με τα χρήματα αυτά, να διασφαλιστεί η συνέχεια του, ό,τι και να
συμβεί. Το OSArena, έχει μια από τις μεγαλύτερες βάσεις
δεδομένων Linux και ΕΛ/ΛΑΚ στον παγκόσμιο
χώρο.

Ακόμα και τώρα δεν είναι λίγες οι φορές που
εκπλησσόμαστε και εμείς οι ίδιοι με το υλικό
του. Μια ματιά στα άρθρα του OSArena και
τα εσωτερικά link που δίνει για οτιδήποτε,
μπορεί να το επιβεβαιώσει αυτό. Όπως και
μια απλή αναζήτηση για οτιδήποτε.

Ξέρουμε και το είδαμε πως το OSArena,
έκανε πολύ κόσμο να καταργήσει το dual
boot και έγινε αφορμή να γνωρίσει
ακόμα περισσότερος κόσμος το Linux
στην Ελλάδα. Αυτό από μόνο του είναι
σπουδαίο και μια ηθική δικαίωση. Αυτό
που θα ήθελα τόσο εγώ, μα και όλοι φα-
ντάζομαι, είναι το OSArena να συνεχίσει
να είναι αυτό που είναι. Ελεύθερο ανε-
ξάρτητο, να φωνάζει για τα στραβά και
άδικα όποτε χρειάζεται και να εμπλουτίζει συνεχώς αυτή τη βάση
δεδομένων που είναι πραγματικός θησαυρός.

Αυτό που θα ήθελα να αναφέρω επίσης, είναι πως το OSArena, ΠΟΤΕ
δεν ζήτησε κάτι από κανέναν. Ούτε βοήθεια, ούτε στήριξη, ούτε την ανταλ-
λαγή banner, ούτε τη προβολή μέσω άλλων μεγάλων ιστοσελίδων.
Το OSArena αντίθετα, στηρίχτηκε στο δικό του δυναμικό και ανέδειξε κοι-
νότητες , ανθρώπους και έργα του ΕΛ/ΛΑΚ. Δεν είναι τυχαίο που η κάθε

κοινότητα που παρουσιάζει κάτι, το δημοσιεύει πρώτα στο OSArena.
Ίσως για πρώτη φορά, είδαμε εκδηλώσεις που είχαν συμμετοχή και νέο
αίμα που ασχολήθηκε, κατόπιν άρθρων και παροτρύνσεων του OSArena
και αυτή η συμμετοχή σε δουλειές ανθρώπων του χώρου μας, μας γεμίζει
σίγουρα με χαρά. Και ουδέποτε ζητήσαμε το παραμικρό σαν αντάλλαγμα.
Και αυτό το λέω δημόσια, ώστε να μπορεί να το αντικρούσει ο οποιοσδή-
ποτε αν δεν ισχύει.

-Η ενασχόληση, ενός ιστότοπου σαν το OSArena, απο-
κλειστικά με το ανοιχτό και ελεύθερο λογισμικό είναι
λίγο παράτολμη, λόγω των λιγοστών ανθρώπων

που ασχολούνται με αυτό. Πως το αντιμετωπί-
ζετε αυτό το πρόβλημα;

Δεν το είδαμε σαν πρόβλημα, είναι η
αλήθεια. Γράφαμε για αυτό που ξέραμε
καλά και μας ευχαριστούσε. Όπως
ανάφερα και παραπάνω το OSArena,
συνέβαλε δραστικά στο να γνωρίσουν
ΚΑΛΑ το Linux περισσότεροι άνθρωποι,
να καταλάβουν τι είναι ανοιχτό λογισμι-

κό. Η αλήθεια είναι πως η συντήρηση του
και η καθημερινή αρθρογραφία που έχει η σε-

λίδα είναι κάτι δύσκολο και γίνεται ένας μικρός η με-
γάλος αγώνας γι' αυτό.

Αν κουράζει και απογοητεύει κάτι ορισμένες φορές, είναι η
κακεντρέχεια που έχουν κάποιοι άνθρωποι, ελάχιστοι ευτυχώς,
μέσα από σχόλια η mail, οι οποίοι προφανώς αγνοούν λέξεις,
όπως: προσφορά, ανιδιοτέλεια.
Χαρακτηριστικό παράδειγμα «ανθρώπου» ο οποίος μου έβριζε
την μητέρα (που δεν ζει πια), επειδή με μια παρουσίαση κάποιας
εφαρμογής του κράσαρε το σύστημα του.
Είχαμε ακόμα και έντονο πόλεμο και «σαμποτάζ» στο ξεκίνημα
του OSArena, από ανθρώπους του χώρου μας, οι οποίοι προφα-
νώς δεν θελαν να υπάρχει μια τέτοια σελίδα, για τους δικούς τους
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λόγους. Προτιμώ να μην αναφέρω συγκεκριμένα παραδείγματα
εδώ, επειδή δεν έχει καμία σημασία.

Μέχρι και απειλή από μεγάλη αγγλόφωνη ιστοσελίδα του χώρου
δεχτήκαμε, με αφορμή αν θυμάμαι καλά, μια ανασκόπηση για το
Ubuntu 1 1 .04.
Αν δείτε αυτό το άρθρο, το οποίο επίσης ήταν αποτέλεσμα συνερ-
γασίας, είναι ότι καλύτερο υπάρχει στον χώρο και σε όλες τις
γλώσσες του κόσμου!
Εκεί λοιπόν, μας είπαν να μην δημοσιεύουμε τέτοια άρθρα, αν
προηγουμένως δεν το κάνουν αυτοί. Μεγάλη ιστορία και τη λέω
πολύ περιληπτικά και ίσως δεν γίνεται αντιληπτό, μα όπως και να
έχει αντιμετωπίσαμε εχθρικές συμπεριφορές. Φυσικά αυτό μας
έκανε να καταλάβουμε πως είμαστε σε καλό δρόμο και απλά αντι-
παρήλθαμε αυτούς τους ανθρώπους και τις συγκεκριμένες κατα-
στάσεις, κάνοντας απλώς αυτό που θέλαμε και όπως θέλαμε.

Αν το ψάξει κάποιος (και όσο ξέρουμε αρκετοί το ψάχνουν), με
τα διάφορα εργαλεία που υπάρχουν η επισκεψιμότητα του
OSArena, είναι στη χειρότερη περίπτωση η τριπλάσια, από όση συ-
γκεντρώνουν όλες μαζί οι ιστοσελίδες (φόρουμ και μπλογκ) του
χώρου μας στον Ελλαδικό χώρο.
Αν δείτε (πχ στο Alexa), το OSArena το λινκάρουν, ιστοσελίδες
κάθε είδους. Εκπαιδευτικές, επιστημονικές, ειδησεογραφικές, από
το opengov και ότι μπορείτε να φανταστείτε.

-Από πόσα άτομα αποτελείται η ομάδα του OSArena; Ποιά είναι
η ανταπόκριση των επισκεπτών;

Ειλικρινά εδώ με πιάνεις αδιάβαστο. Εννοώ δεν μπορώ να σου
δώσω έναν σαφή αριθμό. Από το osarena έχουν περάσει αρκετοί
άνθρωποι και κάτι πολύ σπουδαίο που συνέβη, είναι πως όλοι μα
όλοι ανεξαιρέτως οι αρθρογράφοι, ασχέτως του αριθμού των άρ-
θρων που έχουν ανεβάσει, έχουν ένα τουλάχιστον θέμα που έχει
γίνει best seller!

Σίγουρα υπάρχει μια ομάδα που συντονίζει, μα και άνθρωποι
που ίσως δεν φαίνονται έξω, μα αποτελούν ακρογωνιαίο λίθο για
το OSArena και φυσικά αναφέρομαι στα παιδιά που στελέχωσαν
και στελεχώνουν την τεχνική ομάδα της σελίδας.
Σημαντικό ρόλο όμως έπαιξε και το web-hosting. Αντιμετωπίζο-
ντας κάποια προβλήματα στο παρελθόν, έτυχε και βρεθήκαμε σε
μια εταιρεία (HostingJuice) που επίσης είναι μια συνεργατική δου-
λειά, από Έλληνες και άλλους Ευρωπαίους. Τα παιδιά αυτά, άν-
θρωποι του ΕΛ/ΛΑΚ, είδαν και εκτίμησαν την όλη προσπάθεια και
δυναμική του OSArena και μας έδωσαν πλήρη ελευθερία να
κάνουμε ό,τι θέλουμε, παραχωρώντας δικό μας σέρβερ, μα αντι-
μετωπίζουν και κάθε δύσκολο τεχνικό πρόβλημα στη γέννηση
του! Βέβαια σημαντικό είναι και το γεγονός πως στην ομάδα του
OSArena (την τεχνική), βρίσκονται άνθρωποι οι οποίοι είναι δια-
μάντια, με γνώσεις και μεράκι και σίγουρα, όποια εταιρεία προ-
σλάβει στο μέλλον αυτούς τους ανθρώπους, θα πρέπει να θεωρεί
τον «εαυτό» της, πολύ τυχερό!

Εκπληκτική και η συμμετοχή των αναγνωστών που σχεδόν κα-
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θημερινά μας στέλνουν ιδέες και προτάσεις για άρθρα και μάλιστα
έχουν προκύψει αρθρογράφοι οι οποίοι ξεκίνησαν σαν απλοί επι-
σκέπτες.

Δεν θα κρύψω το γεγονός πως αυτή τη στιγμή το OSArena, περ-
νάει μια μεγάλη κρίση.
Πολύ πρόσφατα είχαμε την απομάκρυνση κάποιων ανθρώπων
της διαχειριστικής ομάδας.
Αιτία για αυτό ήταν κάποια πύρινα άρθρα (κυρίως δικά μου), σχετι-
κά με θέματα όπως το ACTA, ο χακτιβισμός και η εν γένει τοπο-
θέτηση πως η επικράτηση του ΕΛ/ΛΑΚ αποτελεί πολιτική (όχι
κομματική, μη τα συγχέουμε) πράξη.
Έτσι υπήρξε μια διάσπαση η οποία όπως δείχνουν τα πράγματα εί-
ναι μόνιμη.

Αποχωρήσεις είχαμε ακόμα από άτομα της διαχειριστικής
ομάδας και από τους πρωτεργάτες, λόγω οικογενειακών προβλη-
μάτων η ακόμα και οικονομικών. Βλέπετε το OSArena, δεν έχει τη
δυνατότητα να πληρώνει αρθρογράφους, σε αντίθεση με τις αγ-
γλόφωνες ιστοσελίδες του χώρου μας (στις οποίες υπάρχει άκρα-
τος ανταγωνισμός σε θεμιτά και αθέμιτα τις πιο πολλές φόρες
πλαίσια). Είναι κολακευτικό όμως πως οι λεγόμενες διάσημες αγ-
γλόφωνες ιστοσελίδες, κυνηγούν και χρυσοπληρώνουν πρώην αρ-
θρογράφους του OSArena, ώστε να γράφουν σε αυτές.

Και σίγουρα είναι ευχάριστο το να βοηθούνται αυτοί οι άνθρω-
ποι οικονομικά, σε μια εποχή και μια χώρα που το δικαίωμα στη
ζωή και την αξιοπρέπεια έχει εξαφανιστεί, άρα και πολύ σωστά
έπραξαν. Κανείς δεν μπορεί και ούτε πρέπει να τους κατηγορήσει.
Άλλωστε αυτό από μόνο του φανερώνει το επίπεδο και την ανα-
γνωρισιμότητα του OSArena στο παγκόσμιο web.
Σίγουρα όμως βρισκόμαστε σε μια μεγάλη καμπή η οποία θα καθο-
ρίσει το μέλλον, ακόμα και την ύπαρξη του osarena.

-Πως ανακάλυψες το Linux και γιατί αποφάσισες να το «υιοθε-
τήσεις»;

Όπως ανέφερα και παραπάνω, γνώριζα την ύπαρξη του Unix και
του Linux από τα πρώτα τους βήματα. Οι επαγγελματικές ασχολίες
όμως και η ενασχόληση με το δημόσιο και διάφορες εταιρείες
πριν κάποια χρόνια με ανάγκασαν να ασχοληθώ με τα Windows,
τα οποία όμως στο βαθμό που μπορούσα, τα είχα «ντύσει» με
Ανοιχτό/Ελεύθερο Λογισμικό.
Κάποια στιγμή όμως είδα πως ήταν δύσκολο να κάνω απρόσκο-
πτα τη δουλειά μου και με την επιθυμητή παραγωγικότητα με το
λειτουργικό σύστημα της Microsoft, καθώς τότε, πιο πολύ χρόνο
αφιέρωνες για τη συντήρηση των Windows, παρά για την πραγμα-
τική δουλειά..

Ενώ ήμασταν λοιπόν σε εποχές που μόλις είχε κυκλοφορήσει το
Ubuntu, άγνωστο και ασήμαντο ακόμα, έτυχε κάτι πολύ άσχημο
στο επαγγελματικό μου laptop με αποτέλεσμα να χάσω εργασία
εβδομάδων. Βέβαια εκείνη την εποχή ήταν στα πάνω τους διανο-
μές όπως το Mandriva και το Suse (δεν υπήρχε ούτε σαν ιδέα το
open τότε), με το KDE να κυριαρχεί και είχα ήδη μια σεβαστή συλ-
λογή από live cd με διανομές Linux (δύσκολο και αυτό τότε, καθώς
μιλάμε για εποχές με dial-up συνδέσεις και που οι ευρυζωνικές
συνδέσεις ήταν αστείο και ανέκδοτο με τα σημερινά δεδομένα,
όσο αφορά τις ταχύτητες που προσέφεραν.
Έτσι σε συνεργασία με την παιδική μου φίλη Αλίνα (που αρθρο-
γραφεί στο OSArena) η οποία είχε από τότε και λόγω σπουδών,
μα και επειδή της άρεσε, πολλές γνώσεις, περάσαμε ένα δωδε-
κάωρο προκειμένου να επαναφέρουμε το laptop, το οποίο
απέκτησε dualboot, με πρώτη διανομή τότε το Suse και λίγο αρ-
γότερα το διαδέχθηκε το Kubuntu 6.06 (σ' ένα δίσκο των 1 0 Giga).

Αυτό ήταν. Σε λιγότερο από έξι μήνες, κατάλαβα ότι για αυτά
που θέλω σε προσωπικό και επαγγελματικό επίπεδο, με κάλυπτε
το Linux. Το οποίο πλέον και επεκτάθηκε μόνο του στον σκληρό
μου δίσκο και ήταν το μόνο λειτουργικό σύστημα που είχαν και
έχουν τα μεταγενέστερα μηχανήματα που απέκτησα.

-Τι σε γοητεύει και τι σε ενοχλεί στο Linux, το BSD και γενικά
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το ελεύθερο/ανοιχτό λογισμικό;

Η γοητεία μάλλον έχει περάσει και έχει δώσει την θέση της στην
αγάπη. Βέβαια αν με ρώταγες πριν κάποια χρόνια, θα στοιχημάτι-
ζα πως το μέλλον θα ήταν το BSD και όποιος ανατρέξει στην εξέλι-
ξη του, θα καταλάβει γιατί το λέω.
Εκεί όμως ήρθε η Apple που μετέφερε το λειτουργικό της
σύστημα σε αυτό και όλα αλλάξανε. Οι άδειες έγιναν
πιο περιοριστικές, εξαγοράστηκαν άνθρωποι και συ-
νειδήσεις μπορώ να πω και το BSD πότε δεν έγινε για
τις μάζες.

Υπήρχε όμως το Linux που με κάποιους αν-
θρώπους οι οποίοι βλέπανε πιο μπροστά, δεν μπή-
κε σε καλούπια, βασίστηκε σε ανοιχτές και
ελεύθερες άδειες και επικράτησε. Εδώ ερχόμα-
στε και πάλι σε κάτι που ανέφερα και πριν:
Πως το ίδιο το ανοιχτό/ελεύθερο λογισμι-
κό, ήταν και είναι από μόνο του πολιτική
πράξη.

-Τι θα ήθελες να δεις ή να μη δεις κάποια μέρα
στο Linux, BSD και γενικά στον κόσμο του
ανοιχτού και ελεύθερου λογισμικού;

Να διαχωρίσουμε το BSD από τα open και
free BSD, είναι πολύ μεγάλη πλέον η διαφο-
ρά. Δεν θα ήθελα να δω πράγματα που αγα-
πώ να χρησιμοποιούνται με σκοπό να κάνουν κακό σε
ανθρώπους. Αυτό όμως έτσι και αλλιώς συμβαίνει καθώς οι αρχές
ελευθερίας του ανοιχτού λογισμικού, επιτρέπουν την οποιαδήποτε
χρήση του. Αυτό όμως που θα ήθελα να δω είναι τους ανθρώπους
που τα προασπίζουν και τα αναπτύσσουν, να απαγκιστρωθούν
από κάποια κατάλοιπα.
Και μόνο η ύπαρξη των Mac Air, ασχέτως αν αυτά τρέχουν Linux (η

και Linux), καταμαρτυρεί πως όσο και αν αρέσει στους αν-
θρώπους το ανοιχτό και ελεύθερο λογισμικό, ποτέ δεν θα απαλλα-
γούν από τα πρότυπα της μάρκας και της φίρμας η και της
επίδειξης αν θέλετε.
Ίσως ακούγεται ιδεαλιστικό και ουτοπιστικό για μερικούς, μα αν
ολόκληρη η κοινωνία μας υιοθετούσε τον Ανοιχτό Κώδικα σε

κάθε μορφή (τεχνολογικά, οικονομικά, επιστημονικά, κλπ), θα
ζούσαμε σε έναν διαφορετικό και σίγουρα πιο όμορφο
κόσμο, με ίσα δικαιώματα για όλους.

Τέτοια άρθρα έχει ανεβάσει το OSArena, θέλοντας
να κάνει γνωστό στον κόσμο πως εκεί έξω υπάρχουν
και άλλες εναλλακτικές που θα του προσφέρουν μια
άλλη ποιότητα ζωής. Δυστυχώς όμως όλο αυτό το
σύστημα που έχει αρχίσει να δημιουργείται εδώ και
300 χρόνια, της καπιταλιστικής οικονομίας η και
της λεγόμενης σοσιαλιστικής, έχει καταφέρει με
την προπαγάνδα και τα ελεγχόμενα ΜΜΕ να
διαμορφώσει έναν τρόπο ζωής που ακόμα
και αν οι άνθρωποι βλέπουν και αντιλαμ-
βάνονται πως είναι λάθος, δυστυχώς δεν

απαγκιστρώνονται από αυτόν, μα αντίθετα
προσπαθούν με κάθε τρόπο να γίνουν μέρη αυτό
του λαθεμένου συστήματος.
Βλέπετε τα λόγια από τις πράξεις έχουν τεράστια
απόσταση. Άλλωστε οι πράξεις είναι αυτές που
καθορίζουν τον κόσμο μας.

-Ποια είναι η γνώμη σου για τις ελληνικές κοινότητες ανοιχτού
και ελεύθερου λογισμικού;

Είναι πολύ σημαντική και αναγκαία η ύπαρξη τους, μα δυστυχώς
και εδώ υπάρχουν διαμάχες (πχ Fedora κατά Suse), οι οποίες αν
τις καλοσκεφτείτε ξεκινούν από τις στρατηγικές των εταιρειών
που είναι από πίσω και σε αρκετές περιπτώσεις έχουν επηρεάσει
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όσους ασχολούνται.
Αν συγκρίνουμε κάποιες άλλες πιο μικρές κοινότητες με κοινότη-
τες μεγάλων διανομών για παράδειγμα, θα δείτε τη διαφορά στη
πράξη.
Όλοι όμως αυτοί οι άνθρωποι είναι εθελοντές και αυτό είναι πάρα
πολύ σπουδαίο στον κόσμο μας.
Πιστεύω πως αν ξεφύγουν από κάποιες αρτηριοσκληρωτικές
απόψεις και συμπεριφορές και γίνουν πιο ευέλικτες και χωρίς κα-
λούπια, το αποτέλεσμα θα είναι εντυπωσιακό.

Ακόμα και η Κοινότητα του Ubuntu, είναι στο άρμα της
Canonical. Θέλω να πω με αυτό, ότι ακόμα και αν η εταιρεία έγρα-
ψε την κοινότητα στα παλιά της τα παπούτσια (πχ με την έκδοση
1 1 .04), οι «επίσημες» αντιδράσεις από την κοινότητα ήταν χλιαρές.
Αν ήταν στο χέρι μου, θα μάζευα όλες τις κοινότητες σε μια ενιαία
σελίδα, με κατηγορίες στα άρθρα (πχ Ubuntu, Mint, Fedora, Suse,
κλπ). Θα δημιουργούνταν ένας κολοσσός γνώσης και δεδομένων
στο Ελληνικό web και στον μικρο μας χώρο.

Έτσι οι νέοι χρήστες θα ήταν πιο εύκολο να βρουν την πληροφο-
ρία και ο αγώνας όλων για την επικράτηση του ΕΛ/ΛΑΚ θα έβρι-
σκε έδαφος να ριζώσει γερά και εκτός αυτού οι κοινότητες θα
αποκτούσαν μια ισχυρή φωνή που θα ήταν ικανή να αλλάξει πολ-
λά κακώς κείμενα, ακόμα και να επηρεάσει αμαρτωλές
συμφωνίες όπως αυτή του Ελληνικού κράτους με την MS η ακόμα
να επηρεάσει δραστικά, ώστε να είχε επικρατήσει το Ανοιχτό Λογι-
σμικό στην δημόσια διοίκηση.

Κάτι τέτοιο θα μείωνε δραστικά τα έξοδα και ίσως δεν θα έφτα-
ναν στο σημείο οι «σωτήρες» να σμπαραλιάσουν τους μισθούς,
την αξιοπρέπεια και το βιοτικό επίπεδο των ανθρώπων.
Ίσως να μη φτάναμε στο σημείο, όπου και το χαμόγελο ακόμα να
πρέπει να το πληρώσεις...

-Ποιο είναι κατά τη γνώμη σου το μέλλον του Linux, ή όποιου
άλλου ελεύθερου ή ανοιχτού κώδικα λειτουργικού; Πως θα κα-
ταφέρουν γνωστές διανομές να συναγωνιστούν τις «μεγάλες

δυνάμεις» του τομέα;

Όπως είπαμε και πιο πάνω με το παράδειγμα του OSArena, το
οποίο ασχέτως αν είναι μεγάλο στην Ελλάδα και πηγή πληροφο-
ριών και για τους ξένους, η δυναμική είναι μικρή.
Το μεγάλο ψάρι τρώει το μικρό.

Ότι και να συμβεί πάντα τα ΜΜΕ και όλα τα υπόλοιπα θα δια-
στρεβλώνουν την αλήθεια και θα έχουν στην αφάνεια ότι είναι
πραγματικά καλό και χρήσιμο για τους ανθρώπους. Δεν είναι και
λίγοι οι άνθρωποι στην παγκόσμια σκηνή του ΕΛ/ΛΑΚ που εξαγο-
ράστηκαν από μεγάλες εταιρείες.
Οι άνθρωποι αυτοί, σίγουρα βρίσκονταν σε οικονομική απόγνω-
ση, είτε ήθελαν να βελτιώσουν το επίπεδο ζωής τους. Και πάλι ερ-
χόμαστε στη πολιτική πράξη για το ΕΛ/ΛΑΚ. Δυστυχώς το
σύστημα είναι τέτοιο που δεν θα το αφήσει να κυριαρχήσει, άσχε-
τα με το αν υπάρχει αυτή η δυνατότητα.

Εύχομαι ολόψυχα να διαψευσθώ, όμως μια ματιά στον κόσμο
μας, δυστυχώς δείχνει πως έτσι είναι τα πράγματα και πως δεν
έχουν την παραμικρή τάση για ν' αλλάξουν.

-Πόσο σημαντικό θεωρείς ότι είναι για σένα το Android και
πόσο το Linux;

Έχω απαντήσει εμμέσως και πιο πάνω σε αυτό. Το Linux το αγα-
πώ και είναι σημαντικό για εμένα και πρακτικά στην καθημερι-
νότητα μου, καθώς τόσο επαγγελματικά όσο και σε προσωπικό
επίπεδο, βρίσκομαι καθημερινά μπροστά σε έναν υπολογιστή.
Θα έλεγα πως είναι αναντικατάστατο.
Πάνω απ' όλα μιλάμε για ένα λειτουργικό σύστημα που με την ευε-
λιξία του, μου/μας δίνει δυνατότητες που μόνο η φαντασία μπορεί
να περιορίσει.

Το Android αυτή τη στιγμή είναι η ελίτ στα λειτουργικά συστήμα-
τα φορητών συσκευών, μα δεν το κρύβω πως με ενοχλεί αφάντα-
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στα πως είναι ιδιοκτησία της Google η οποία ασχέτως του τι προ-
σπαθεί να μας πείσει είναι πραγματικά evil! Και μια λεπτομέρεια
εδώ που ίσως κάποια στιγμή (εύχομαι όχι) , να αποδειχθεί αχίλ-
λειος πτέρνα. Η Google δεν βασίστηκε (για το ChromeOS, έστω)
στο Linux, μα δημιούργησε ένα fork του πυρήνα Linux.

-Ποια είναι η γνώμη σου για την δημοφιλέστερη διανομή Linux
το Ubuntu; Οι εντυπώσεις σου για το Unity;

Κακά τα ψέματα, το Ubuntu άλλαξε καθοριστικά το τοπίο σε αυ-
τόν τον χώρο. Έβαλε το Linux σε οικιακά περιβάλλοντα, σε επαγ-
γελματικά (μιλάω για desktop) και τέλος πάντων έφερε το Linux
στις μάζες, καταρρίπτοντας μύθους και ψεύτικες διαδόσεις που κα-
τασκεύαζαν εταιρείες όπως η MS, Apple, Oracle, κλπ, γι' αυτό.
Το Unity είναι καινοτόμο, είναι διαφορετικό και αν είναι κάτι που
εγείρει τις αντιδράσεις είναι αυτή του η διαφορετικότητα και όχι
επειδή είναι δύσκολο η μη χρηστικό.

Πιστεύω ότι το 201 2 θα είναι καθοριστικό για το Unity και
βέβαια τον μεγαλύτερο ρόλο σε αυτό θα παίξει το να έχει η
Canonical ανοιχτά τα αυτιά της στις εμπεριστατωμένες προτάσεις
και παρατηρήσεις των χρηστών, αλλιώς θα καταντήσει να ρίχνει
στην αγορά ένα σύστημα χωρίς system tray (βλέπε 1 1 .04).

Μου άρεσε η ιδέα του HUD, μα το βρίσκω τραγικό, αν αληθεύ-
ουν τα λεγόμενα βέβαια, να αντικαταστήσει πλήρως το μενού.
Με τα υπάρχοντα δεδομένα όμως και με προϊόντα όπως το
Ubuntu for Android (το Ubuntu TV, το θεωρώ υπερεκτιμημένο και
όχι κάτι καινοτόμο η συνταρακτικό) , πιστεύω πως η πρόβλεψη
του Mr. Ubuntu, για 200 εκατομμύρια χρήστες ως το 201 5, δεν
απέχει από την πραγματικότητα.

-Πως αξιολογείς τις προθέσεις της Canonical και την πορεία
που έχει δώσει στο Ubuntu;

Μη ξεχνάμε πως η Canonical, είναι πρώτα απ' όλα εταιρεία και
όχι φιλανθρωπικό ίδρυμα. Αυτό από μόνο του συνεπάγεται πως
της αρέσει δεν της αρέσει, θα πρέπει να παίξει με τους κανόνες
της αγοράς και του συστήματος, όπως αυτοί έχουν διαμορφωθεί.
Αυτό σημαίνει πως θα προωθεί το προϊόν της, όπως νομίζει ότι
την συμφέρει καλύτερα και λογικό είναι. Εδώ όμως έχουμε δυο
φαινόμενα που αξίζει να τα αναφέρουμε.

Το ένα ο Mark Sh. που κάνει κάτι που δεν μας έχουν συνηθίσει
άλλοι. Δεν θα μπορούσα ποτέ να φανταστώ τον Gates η τον Jobs
για παράδειγμα, να μετέχουν σε συζητήσεις με τους χρήστες, να
δίνουν αναφορές σφαλμάτων στο Launchpad και να έχουν ενεργή
ανάπτυξη στο χτίσιμο και στήσιμο του λειτουργικού.

Από την άλλη υπάρχει μια εμμονή και δικαιολογημένη όπως εί-
παμε, στο να προωθήσει τα προϊόντα που παράγει η εταιρεία. Αυ-
τό ειδικά στο θέμα του Unity, έχει οδηγήσει σε κάμποσα λάθη και
ο λόγος είναι πως η επικέντρωση ήταν στην ίδια την καινοτομία
του προϊόντος και όχι στην καθεαυτή του λειτουργικότητα.
Έχω την αίσθηση πως όσο η Canonical δεν αναπτύσσει δικές της
εφαρμογές (πχ για Multimedia) και κάθε τόσο πηδάει από τη μια
εφαρμογή στην άλλη, ποτέ το Ubuntu, δεν θα έχει μια ομοιογενή
εικόνα και πάντα θα δίνει σε πιο νέους χρήστες την αίσθηση μιας
συνεχούς δοκιμαστικής έκδοσης. Και αυτό δεν είναι έτσι όπως
ξέρουμε, μα δυστυχώς αυτό βγαίνει προς τα έξω.

Και για να είμαστε ειλικρινείς, την Canonical δεν την ενδιαφέρει
και τόσο η γνώμη και η άποψη χρηστών που δεν έχουν σαν βασι-
κή τους γλώσσα τα Αγγλικά. Η αγορά που κινείται είναι καθαρά
αυτή της Μεγάλης Βρετανίας και της Αμερικής.
Ένα μεγάλο λάθος, κατά τη γνώμη μου πάντα, είναι πως έχει ευνο-
ήσει ένα κλίμα φαν-μποισμού, το οποίο το τελευταίο διάστημα
έχει αρχίσει να της γυρνάει μπούμερανγκ.
Μια ματιά στα επιχορηγούμενα από την Canonical μπλογκ, με τα
στιγμιότυπα από τα Mac air και το iphone από δίπλα μπορεί να το
επιβεβαιώσει αυτό. Ακόμα και στα γραφεία της στο Λονδίνο
(Μέιν), οι συσκευές της Apple έχουν τον πρώτο λόγο.
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Ελπίζω αυτό να το έχουν καταλάβει πια και με την έλευση των συ-
σκευών με ντιζάιν και στο hardware για Ubuntu να αλλάξουν τα
πράγματα.

Δεν είναι δυνατόν ο ιδρυτής της Canonical, να προωθεί το Ubuntu
for Android, έχοντας στη τσέπη το iphone, το οποίο και έχει εξυμνήσει
κατά το παρελθόν με δηλώσεις του.
Είναι κάπου fail αυτό, δε νομίζετε;

-Κάποιο μήνυμα προς τους αναγνώστες μας Κωνσταντίνε;

Μη βαριέστε. Ο κόσμος για να χτιστεί χρειάστηκε δουλειά από πολ-
λούς. Αν μάθατε κάτι που αξίζει να το ξέρουν και άλλοι, ανεβάστε το
στο φόρουμ της κοινότητας η στείλτε το και στο OSArena να δημοσιευ-
τεί, μ' εσάς σαν αρθρογράφους.
Κάποια στιγμή αυτοί οι λίγοι που προσφέρουν, θα βαρεθούν, θα κου-
ραστούν, θα τους απορροφήσουν τα προβλήματα της δικής τους καθη-
μερινότητας και τότε τι θα γίνει;

Ας σηκωθούμε από τους καναπέδες γενικότερα. Ας ενώσουμε τις δυ-
νάμεις μας, να κάνουμε τον κόσμο μας καλύτερο.
Και ο κόσμος μας αυτή τη στιγμή είναι αξιοθρήνητος για τον καθημερι-
νό άνθρωπο και απολύτως εχθρικός. Και αυτό είναι λάθος σίγουρα.
Unfuck the world, λένε οι ακτιβιστές και αυτό ακριβώς πρέπει να
κάνουμε. Και μοναχά όλοι μαζί μπορούμε να τα καταφέρουμε.
Και πρέπει να δράσουμε ΤΩΡΑ, σήμερα. Αύριο ίσως να είναι αργά. Δεί-
τε τα σημάδια γύρω μας. Οι ατομικές ελευθερίες είναι είδος προς εξα-
φάνιση. Σας αρέσει αυτό;

Η τεχνολογία πρέπει να είναι εργαλείο για τους ανθρώπους και όχι
να την χρησιμοποιούν οι κατέχοντες ώστε να ελέγχουν τις κοινωνίες.

>>>Κάποιες γενικές ερωτήσεις:

-Ποια είναι η αγαπημένη σου ασχολία, πέρα από το Linux και τη συγ-
γραφή άρθρων;

Διάφορα «χαζά» αθλήματα που κάποιοι (κακώς) τα συγκαταλέγουν
στα xtreme sports, όπως κανό-καγιάκ, paintball (δοκιμάστε το, έχει
πολύ πλάκα), μα πάνω απ' όλα με συναρπάζουν τα ταξίδια και οι εξε-
ρευνήσεις νέων για μένα τόπων.
Κάποτε είχα τη δυνατότητα να ταξιδεύω πολύ συχνά και έτσι γνώρισα
πολλά μέρη και διαφορετικές κουλτούρες.
Αυτά τα ταξίδια ήταν και μάθημα ζωής, καθώς συνειδητοποίησα πόσο
μοιάζουμε οι άνθρωποι ασχέτως χρώματος, φυλής και τόπου καταγω-
γής.

-Έχεις κάποια συγκεκριμένη αδυναμία;

Ναι φυσικά. Τα ζώα. Τα λατρεύω και μου είναι αδύνατο να τους
κάνω κακό η να μη βοηθήσω κάποιο ζώο. Δεν θα μπορούσα να φα-
νταστώ την ζωή μου, την καθημερινότητα μου, χωρίς γαβγίσματα, νια-
ουρίσματα και τιτιβίσματα!

-Αν ήθελες να κλεί-
σεις τα μάτια σου
και όταν τα ανοίξεις
να βρεθείς σε μια
άλλη χώρα, ποιά θα
ήταν αυτή και γιατί; (
λίγο γενική και πιο
φιλική ερώτηση)

Η Λιλιπούπολη φυ-
σικά!
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Το DoudouLinux είναι μια διανομή βασισμένη σε Debian και
απευθύνεται σε μικρά παιδιά από 2 ετών και άνω. Οι στόχοι της
διανομής είναι να κάνει τη χρήση του υπολογιστή όσο το δυνατόν
πιο απλή και ευχάριστη, καθιστώντας την προσιτή στα παιδιά. Το
DoudouLinux χρησιμοποιεί προσαρμοσμένο περιβάλλον εργασίας
LXDE με ένα απλό σύστημα περιήγησης που προσφέρει περίπου
πενήντα εφαρμογές εκπαίδευσης, διασκέδασης, εργασίας και πο-
λυμέσων. Η διανομή είναι διαθέσιμη σε 25 γλώσσες συμπεριλαμ-
βανομένης και της Ελληνικής.

Ελληνική έκδοση:

http://download.doudoulinux.org/file/livecd/current/doudoulin
ux-gondwana-1 .1 -el.iso

Η διανομή τρέχει μόνο από cd ή usb αλλά όχι ενώ τρέχει κάποιο
άλλο λειτουργικό σύστημα. Εκκινώντας τον υπολογιστή με το με
το cd ή το usb που έχουμε δημιουργήσει, ξεκινάει το
DoudouLinux με μια όμορφη και παιχνιδιάρικη οθόνη με τα μενού
7 δραστηριοτήτων και εφαρμογών της διανομής υπό τους ήχους
παιδικήςμουσικής.

Πρώτη ενότητα το «Gamine», είναι μια εφαρμογή που βοηθά
τους μικρούς μας φίλους να συνηθίσουν την κίνηση του ποντι-
κιού, χρησιμοποιώντας ένα μολύβι που γράφει στα χρώματα του
ουράνιου τόξου... Στη δεύτερη ενότητα βρίσκεται το «Pysycache»
το οποίο περιλαμβάνει διάφορα παιχνίδια με μόνο σκοπό την εκ-
παίδευση των παιδιών στη χρήση και την κίνηση του ποντικιού.
Στην ενότητα «Childsplay» περιλαμβάνονται παιχνίδια μνήμης,

DoudouLinux 1. 1 Μια διανομή για παιδιά τουΓιώργουΧριστοφή

http://download.doudoulinux.org/file/livecd/current/doudoulinux-gondwana-1.1-el.iso
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αναγνώρισης χρωμάτων και ήχων ζώων, εφαρμογές εκμάθησης
της Αγγλικής γλώσσας και των αριθμών της με φωνητική επιλογή.
Από το αρχικό μενού της διανομής, δε θα μπορούσε να λείπει η
αγαπημένη εφαρμογή ζωγραφικής για τα παιδιά το TuxPaint!

Επόμενη ενότητα το «Gcompris» με εκπαιδευτικά παιχνίδια για
παιδιά από 2 έως 1 0 ετών που μάλιστα μιλούν και Ελληνικά! Μέσω
των παιχνιδιών, τα παιδιά μπορούν να μάθουν το Ελληνικό αλ-
φάβητο, τους αριθμούς και τα χρώματα, με δυνατότητα Ελληνικής
φωνητικής υποστήριξης.

Στη επόμενη ενότητα βρίσκεται το «Mini DoudouLinux», το
οποίο επιλέγοντάς το έχει τη μορφή που έχει ένα κανονικό λει-
τουργικό σύστημα. Στην κορυφή της οθόνης υπάρχει μια μπάρα
με 2 καρτέλες , την καρτέλα “Εκμάθηση” και την καρτέλα “Ρυθμί-
σεις”, ενώ πάνω δεξιά στη οθόνη υπάρχει η ώρα συστήματος, η
ρύθμιση της έντασης ήχου, το εικονίδιο δικτύου και τα κουμπιά
αποσύνδεσης και τερματισμού.

Όι εφαρμογές Gamine, Pysycache, Childsplay, TuxPaint και
Gcompris που αναφέρθηκαν παραπάνω, και μερικές ακόμη, βρί-
σκονται στην καρτέλα “Εκμάθηση”. Επίσης είναι διαθέσιμος και ο
κειμενογράφος Gedit. Στην καρτέλα “Ρυθμίσεις” τα παιδιά μπο-
ρούν να αλλάξουν το προφίλ του ήχου, την ταχύτητα του ποντι-
κιού κ.α..

Τέλος με την ενότητα «Πλήρες DoudouLinux» , έχουμε πρόσβαση
σε όλα τα παραπάνω ενώ υπάρχουν οι επιπλέον καρτέλες “Εργα-
σία”, “Απολαύστε” και “Πολυμέσα”. Στις επιπλέον καρτέλες τα παι-
διά έχουν τη δυνατότητα ρυθμίσεων του συστήματος, την
εκτύπωση εγγράφων σε .pdf ή κανονική εκτύπωση αν υπάρχει
εκτυπωτής συνδεδεμένος στον υπολογιστή, την αναπαραγωγή μου-
σικής και ταινιών με το Totem, τη δημιουργία βίντεο με μορφή
animation από εικόνες ή βίντεο με το πρόγραμμα Stopmotion, περι-
ήγηση στο διαδίκτυο με το Epiphany και ανταλλαγή μηνυμάτων με
το Empathy (μόνο σε τοπικό δίκτυο και όχι στο διαδίκτυο).
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Επιπλέον υπάρχουν: πρόγραμμα διαχείρισης συμπιεσμένων αρ-

χείων, το λεξικό Opendict, αριθμομηχανή και τερματικό!!!

Στα εκπαιδευτικά παιχνίδια προστέθηκαν η κρεμάλα (για αγγλι-
κές λέξεις) και το KGeography για την εκμάθηση χωρών και πρω-
τευουσών του κόσμου. Επίσης με το Πλήρες DoudouLinux,
υπάρχουν παιχνίδια για διασκέδαση, όπως σκάκι, Σεραφίνο,
SuperΤuxkart, παιχνίδια με κάρτες και άλλα.

Στην καρτέλα Ρυθμίσεις, πέραν αυτών που αναφέρονται στο
Mini DoudouLinux υπάρχουν ρυθμίσεις για την ανάλυση της
οθόνης, των αρχικών μενού, όπως επίσης και για το υλικό που εί-
ναι εγκατεστημένο στον υπολογιστή.

Πηγές:
Ιστιοτόποςδιανομής: www.doudoulinux.org

Κατέβασμα Ελληνικήςέκδοσης :

http://download.doudoulinux.org/file/livecd/current/doudoulinux-gondwana-

1.1-el.iso

http://www.doudoulinux.org
http://download.doudoulinux.org/file/livecd/current/doudoulinux-gondwana-1.1-el.iso
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Ποιόν πλοηγό ή φυλλομετρητή (κοινώς browser) χρησιμοποιεί-
τε; Σας ικανοποιεί; Είναι ο καλύτερος; Ξέρετε αν υπάρχουν κι άλ-
λοι, ίσως καλύτεροι; Στο άρθρο αυτό θα κάνουμε μια σύντομη
περιγραφή των πιο γνωστών -αλλά και άλλων, λιγότερο γνωστών-
προγραμμάτων πλοήγησης στο Διαδίκτυο.

Ολίγη ιστορία

Το Internet δημιουργήθηκε κατά τη διάρκεια του ψυχρού πο-
λέμου στα τέλη της δεκαετίας του 1 960 από το υπουργείο
Άμυνας των Η.Π.Α. σε μια προσπάθεια διασύνδεσης των υπολο-
γιστικών του δικτύων. Έτσι γεννήθηκε το ARPANET (Advanced
Research Projects Agency NETwork) το οποίο αποτελεί τον πρόγο-
νο του Internet. Σκοπός των δημιουργών του ήταν η κατασκευή
ενός δικτύου το οποίο θα μπορούσε να λειτουργεί ακόμα κι αν κα-
ταστρέφονταν μερικοί υπολογιστές (ή κόμβοι) του σε περίπτωση
πυρηνικού πολέμου. Την ίδια ιδιότητα χαρακτηρίζει σήμερα και το
Διαδίκτυο. Έτσι, αν π.χ. καταστρεφόταν η γραμμή που συνδέει
τον κόμβο της Αθήνας με τον κόμβο της Λάρισας, τότε τα δεδο-
μένα θα μπορούσαν να συνεχίσουν να μεταφέρονται μέσω του
κόμβου του Βόλου.

Αρχικά, το ARPANET χρησιμοποιήθηκε για να συνδέει μεταξύ
τους κόμβους πανεπιστημιακών ιδρυμάτων και ερευνητικών
κέντρων των Η.Π.Α. Το 1 973 συνδέεται το University College
London και σιγά-σιγά το ARPANET, το οποίο από το 1 983 παίρνει
την ονομασία Internet, διασυνδέει τα πανεπιστήμια όλου του
κόσμου. Ήδη από το 1 980 διατίθεται σε όλους κι όχι μόνο στα πα-
νεπιστημιακά ιδρύματα.

Το Διαδίκτυο όμως γίνεται ευρύτερα γνωστό το 1 990 μετά την
ανάπτυξη του Παγκόσμιου Ιστού (World Wide Web - WWW)
από τον Βρετανό ερευνητή του Ευρωπαϊκού Εργαστηρίου Μορια-
κής Φυσικής της Γενεύης (CERN) Τιμ Μπέρνερ-Λι. Αυτό δίνει στους

χρήστες τη δυνατότητα να έχουν πρόσβαση σε μια μεγάλη ποικι-
λία πληροφοριών, όπως κείμενο, εικόνα και ήχο!

Από εκεί και πέρα ένα πλήθος προγραμμάτων εμφανίζονται
με αποκορύφωμα το πλέον δημοφιλές Mosaic το 1 993 από τον
22άχρονο μόλις φοιτητή Μαρκ Άντρισεν, ένα επαναστατικό
πρόγραμμα πλοήγησης στο Διαδίκτυο φιλικό προς τον χρήστη.
Με το πρόγραμμα αυτό καθίσταται δυνατή η ταυτόχρονη θέαση
μπροστά στο χρήστη εικόνων, κειμένου, βίντεο και ήχου. Η τε-
ράστια επιτυχία αυτού του προγράμματος (1 εκατ. πωλήσεις
μέσα στο 1 993!) είχε ως αποτέλεσμα τη δημιουργία από τους
Άντρισεν και Κλαρκ της Netscape Communications και του πασί-
γνωστου πλέον προγράμματος πλοήγησης στο Διαδίκτυο
Netscape Navigator το οποίο διατίθεται στην τιμή των $50. Το
Netscape χρησιμοποιεί τη δυνατότητα υπερκειμένου (hypertext)
που προσφέρει το WWW η οποία επιτρέπει στον χρήστη να μετα-
βεί από μια ιστο-σελίδα σε μια άλλη επιλέγοντας απλώς το σύνδε-
σμό τους (hyperlink) με ένα μόνο κλικ του ποντικιού.

Η Microsoft ζητά την εξαγορά της Netscape η οποία όμως της
αρνείται κι ως απάντηση διαθέτει το δικό της πρόγραμμα πλοήγη-
σης, τον Internet Explorer, δωρεάν για να διαλύσει τον ανταγωνι-
σμό της Netscape. Η Netscape αναγκάζεται να διαθέσει κι αυτή το
πρόγραμμά της δωρεάν, πράγμα που την οδηγεί στη χρεωκοπία.

Για μερικά χρόνια ο ΙΕ είναι το κατεξοχήν πρόγραμμα πλοήγη-
σης στο Διαδίκτυο. Η Netscape ανοίγει τον κώδικα του Navigator
ο οποίος μετονομάζεται σε Mozilla. Εντωμεταξύ, ένας 1 5-χρονος,
ο Blake Aaron Ross μαζί με τον Dave Hyatt, διαβάζουν τον κώδικα
του Netscape Navigator και το 2004 δημιουργούν βασισμένοι σ'
αυτόν ένα νέο πλοηγό, τον Firefox. Ο νέος αυτός πλοηγός απειλεί
την πρωτοκαθεδρία του ΙΕ και μέσα σε λίγο καιρό γίνεται ο πιο
δημοφιλής πλοηγός καθώς είναι γρηγορότερος, ασφαλέστερος
και με περισσότερες καινοτομίες από τον ΙΕ.

Πλοηγοί τουΓιάννη Κωστάρα
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Εντωμεταξύ, κι άλλοι πλοηγοί διατίθενται στην αγορά, όπως ο

Opera, και ο Safari για το MacOS. Το 2009 η Google ανακοίνωσε
τη δημιουργία του δικού της πλοηγού ο οποίος υπόσχεται να είναι
απλός στη χρήση και πιο γρήγορος από οποιονδήποτε άλλον πλοη-
γό της αγοράς. Και εγένετο ο Chrome, ο οποίος πρόσφατα ξεπέρα-
σε τον Firefox σε προτίμηση των χρηστών [1 .] .

Στη συνέχεια θα παρουσιάσουμε μερικούς από τους πιο γνω-
στούς πλοηγούς που μπορείτε να τρέξετε στο Ubuntu.

Πιο δημοφιλείςπλοηγοίτου 2011 (Πηγή: [1.])

Mozilla Firefox

Έρχεται μαζί με το Ubuntu και είναι ο εξ' ορισμού φυλλομετρη-
τής του (κατιτίς όπως ο Internet Explorer είναι ο εξ' ορισμού πλοη-
γός για τα Windows και ο Safari για τα Mac).

Mozilla Firefox
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Vidalia Tor

Πρόκειται για έναν κλώνο του Firefox ο οποίος σας παρέχει
ασφάλεια και ανώνυμη πλοήγηση στο Internet. Μπορείτε να τον
εγκαταστήστε από το Ubuntu Software Center όμως εκεί υπάρχει
μόνο το Vidalia Control Panel. Μπορείτε να κατεβάσετε μαζί τον
Tor Browser και το Vidalia Control Panel από εδώ:
https://www.torproject.org/projects/torbrowser.html.en και απλά
τον αποσυμπιέζετε σε κάποιον φάκελο. Στη συνέχεια εκτελείτε το
αρχείο start-tor-browser και voila.

Vidalia ControlPanel

Τorbrowser, ip-secrets: Σίγουρα δεμένω στο San Fransisco ανκαι θα 'θελα

Αν κανένα άλλο πρόγραμμα δε χρησιμοποιεί τη θύρα 9050, τότε
θα δείτε την παραπάνω εικόνα, διαφορετικά «σκοτώστε» πρώτα
το πρόγραμμα που χρησιμοποιεί την ανωτέρω θύρα.

Αν και αργός, ο Tor σας επιτρέπει να πλοηγήστε ή να συζητάτε
ανώνυμα και με ασφάλεια στο Διαδίκτυο. Παρόλα αυτά, μπορείτε
να πλοηγείστε γρήγορα πληρώνοντας κάποιο αντίτιμο.

https://www.torproject.org/projects/torbrowser.html.en
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Google Chromium

Google Chromium

Είναι ο δημοφιλής πλοηγός της Google και στην έκδοση για
Ubuntu ονομάζεται Chromium αντί για Chrome. Προσφέρεται για
εγκατάσταση στο Ubuntu Software Center. Είναι ο πλοηγός που
αυτή τη στιγμή έχει την καλύτερη υποστήριξη των νέων προτύ-
πων, όπως θα δείτε στο τέλος αυτού του άρθρου, ενώ η Google
στηρίζει πάνω του το λειτουργικό της σύστημα [2.] (ναι, καλά δια-
βάσατε!) .

SRWare Iron

Iron

Πρόκειται για έναν κλώνο του Chrome (ή Chromium) από την SRWare.
Δυστυχώς δεν υπάρχει ακόμα στο Ubuntu Software Center, αλλά μπο-
ρείτε να τον κατεβάσετε από:
http://www.srware.net/forum/viewtopic.php?f=1 8&t=2934 είτε ως tarball
είτε ως .deb αρχείο. Κατεβάστε το .deb αρχείο και κάντε διπλό κλικ πάνω
του για να το εγκαταστήσετε. Θα δείτε ένα μήνυμα στο Ubuntu Software
Center το οποίο σας προειδοποιεί να εγκαταστήσετε το αρχείο μόνο αν
εμπιστεύεστε την πηγή του. Πατήστε Install για να συνεχίσετε.

Μοιάζει πολύ με τον Chromium, και αν θέλετε να τον δείτε να τρέχει
φροντίστε να είναι κλειστός ο Chromium, αλλιώς θα φορτώσει εκείνος.

http://www.srware.net/forum/viewtopic.php?f=18&t=2934
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Η διαφορά του απ' τον Chrome είναι ότι εξαλείφει κάποια θέματα προ-
στασίας απορρήτου όπως η δημιουργία μιας μοναδικής ταυτότητας χρή-
στη και η αποστολή δεδομένων στην Google [3.] .

Konqueror

Konqueror

Για όσους δεν το γνωρίζανε, ο Konqueror και ο Safari μοιράζο-
νται το Webkit εδώ και χρόνια [4.] . Παρόλ' αυτά, πρόκειται για δυο
διαφορετικούς πλοηγούς. Αποτελεί άλλον ένα προεγκατεστημένο
πλοηγό του Ubuntu, αν κι όχι με τόσες δυνατότητες όσο ο Firefox.
Πρόκειται για το διαχειριστή των αρχείων σας (κάτι σαν τον
Windows Explorer) ο οποίος όμως διαθέτει και δυνατότητες πλοή-
γησης.

Epiphany

Epiphany

Ακόμα ένας πλοηγός που βασίζεται στο WebKit, διαθέσιμος για
GNOME που μπορείτε να τον βρείτε στο Ubuntu Software Center.
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NetSurf

NetSurf

Πρόκειται για έναν απλό πλοηγό που μπορείτε να κατεβάσετε
από το Ubuntu Software Center. Δυστυχώς δεν υποστηρίζει τα
νέα πρότυπα ακόμα.

Opera

Opera

Πρόκειται για έναν αρκετά γρήγορο πλοηγό που βρίσκεται στην
αγορά εδώ και πολλά χρόνια και πλέον διατίθεται δωρεάν. Κατε-
βάστε τον από εδώ: http://www.opera.com/browser/download/
ως debian package και εγκαταστήστε τον όπως περιγράψαμε πα-
ραπάνω για τον Iron. Τρέχει σε κάθε συσκευή και έχει τη δυνα-
τότητα caching των ιστοσελίδων σας για μεγαλύτερη ταχύτητα
αλλά και άλλες καινοτομίες.

http://www.opera.com/browser/download/
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Safari

Safari

Αν και η Apple διαθέτει έκδοσή του για τα Windows, δεν υπάρ-
χει έκδοση για Linux, οπότε ο μόνος τρόπος να τον εγκαταστήσετε
είναι μέσω winetricks. Ξεκινήστε την εφαρμογή winetricks, και
στην οθόνη “Choose a wineprefix” επιλέξτε “Install an app”. Στην
επόμενη οθόνη “Which package(s) would you like to install?” επι-
λέξτε τον Safari. Μετά από λίγη αναμονή θα δείτε το εικονίδιο του
Safari στην επιφάνεια εργασίας σας. Εδώ θα βρείτε μια σύγκριση
του Safari με τον Epiphany:

http://web-browsers.findthebest.com/compare/1 -1 7/Safari-vs-

Epiphany.

InternetExplorer8

Internet Explorer
Μπορείτε να εγκαταστήσετε τον εξ' ορισμού πλοηγό των

Windows μέσω του winetricks. Θα μου πείτε, τι τον θέλω τον ΙΕ τη

στιγμή που έχω τον Firefox ή κάποιον από τους προαναφερ-

θέντες. Δυστυχώς, υπάρχουν ακόμα κάποιοι ιστοτόποι (ακόμα και

γνωστών ελληνικών τραπεζών) που δουλεύουν μόνο με ΙΕ! Για να

μη χρειαστεί λοιπόν να μπείτε στα Windows για να δείτε τις συναλ-

λαγές σας στο web banking, εγκαταστήστε τον ΙΕ στο wine.

http://web-browsers.findthebest.com/compare/1-17/Safari-vs-Epiphany
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Από την αρχική οθόνη του winetricks, επιλέξτε “Select the default

wineprefix” --> “Install a Windows DLL or component” και επιλέξτε

«ie8». Κάντε υπομονή όσο εγκαθίσταται ο ΙΕ και αν όλα πάνε καλά,

αφού σας ζητηθεί να επανεκκινήσετε το wine θα δείτε τον ΙΕ 8 να

τρέχει στο Ubuntu σας.

Συγκρίσεις

Ο παρακάτω πίνακας συγκρίνει τους διάφορους πλοηγούς στο
κατά πόσο υποστηρίζουν καρτέλες (tabs), HTML 5, CSS 3 και
Javascript [5.] . Η βαθμολογία για την HTML 5 προέρχεται από το:
http://html5test.com/.
Οι υπόλοιπες αξιολογήσεις από το: http://fmbip.com/ (όπου θα
πρέπει να έχετε ενεργοποιημένη τη JavaScript) .

Υποστήριξη νέωνπροτύπων

Επίλογος

Δίνοντας “web browser” στο Ubuntu Software Center θα βρείτε
τουλάχιστον μια ντουζίνα ακόμα πλοηγούς, όπως π.χ. oι Arora,
Dooble, Elinks, Midori, Links2, Luakit κ.ά. Σε αυτό το άρθρο περιο-
ριστήκαμε στους πιο γνωστούς.

Πηγές
1. http://www.techgear.gr/google-chrome-two-points-above-firefox-36309/

2. http://getchrome.eu/

3. http://www.srware.net/en/software_srware_iron_chrome_vs_iron.php

4. http://news.zdnet.co.uk/software/0,1000000121,39145507,00.htm

5. http://www.deepbluesky.com/blog/-/browser-support-for-css3-and-html5_72/

http://html5test.com/
http://fmbip.com/
http://www.techgear.gr/google-chrome-two-points-above-firefox-36309/
http://getchrome.eu/
http://www.srware.net/en/software_srware_iron_chrome_vs_iron.php
http://news.zdnet.co.uk/software/0,1000000121,39145507,00.htm 
http://www.deepbluesky.com/blog/-/browser-support-for-css3-and-html5_72/
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τουΓιάννη Κωστάρα

Στο προηγούμενο τεύχος δώσαμε μια εισαγωγή στα κελύφη του
Linux και μιλήσαμε για το bash. Είδαμε τους βασικούς τύπους: αριθ-
μούς, αλφαριθμητικά και πίνακες, καθώς και τις εντολές ελέγχου και
επανάληψης. Στο 2ο και τελευταίο μέρος θα μιλήσουμε για συναρτή-
σεις, εντολές εισόδου/εξόδου και διεργασίες ελπίζοντας να έχουμε κα-
λύψει το μεγαλύτερο μέρος των εντολών κελύφους με χρήσιμα
παραδείγματα. Προτού όμως προχωρήσουμε στις συναρτήσεις, ας
δούμε μερικά ακόμα χρήσιμα στοιχεία.

Υπολογισμός εκφράσεων

Το κέλυφος είναι κι ένα χρήσιμο κομπιουτεράκι, αν τύχει και δεν σας
βρίσκεται κάποιο πρόχειρο. Η αντίστοιχη εντολή είναι η expr:

# \* γιατί το * είναι ο χαρακτήρας μπαλαντέρ

$ expr 5 – 3 \* 2

- 1

$ expr \( 5 - 3 \) \* 2

4

# / = div ακέραια διαίρεση

$ expr 10 / 3 + 4

7

# % = modulo ακέραιο υπόλοιπο

$ expr 20 % \( 7 + 2 \)

2

$ expr substr "playground" 5 6

ground

# γιατί το u βρίσκεται στη θέση 3

$ expr index "Ubuntu" " stu"

3

$ expr length " Ubuntu"

6

Δώστε μεγάλη σημασία στο να αφήνετε κενά μεταξύ των τελε-
στέων, των τελεστών και των παρενθέσεων αλλιώς θα δείτε μηνύ-
ματα λάθους όπως τα παρακάτω:

expr: syntax error

expr: non- integer argument

Φυσικά ισχύουν όσα είπαμε και στο προηγούμενο τεύχος όσον
αφορά την προτεραιότητα των τελεστών.

Εναλλακτικά μπορείτε να χρησιμοποιήσετε και τους τελεστές

$(( )) και $[ ] :

$ echo $((5 – 3 * 2))

- 1

$ echo $[10 / 3 + 4]

7

Σήματα και παγίδες

Σήμα (signal) είναι μια διακοπή (interrupt) που στέλνεται σε μια διερ-
γασία από το λειτουργικό σύστημα. Συνήθως, μια διεργασία τερματί-
ζεται όταν δέχεται ένα τέτοιο σήμα. Στο πρόγραμμά σας όμως τέτοια
σήματα μπορεί να είναι χρήσιμα για να κάνετε π.χ. ξεκαθάρισμα
πόρων πριν τερματίσετε τη διεργασία σας, να τα αγνοήσετε μέσα σε
κρίσιμα τμήματα κλπ. Βέβαια, μπορείτε κι εσείς μέσα από το πρόγραμ-
μά σας να στέλνετε σήματα σε διεργασίες, αλλά μια διεργασία αγνοεί
όλα τα άλλα σήματα πέραν αυτών που έρχονται από τον υπερχρήστη
(root) ή τον χρήστη που τη δημιούργησε.

Προγραμματισμός Κελύφους (Μέρος 2ο)
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Η εντολή είναι η

kill - signal PID| JOBID

όπου signal ένα από τα παρακάτω. Το εξ' ορισμού είναι το TERM.

Κάθε εντολή ή πρόγραμμα που εκτελείται στο κέλυφος του
Linux αποκτά από το σύστημα έναν μοναδικό αριθμό ταυτότητας
που ονομάζεται PID ή Process ID. Η εντολή ps μας δίνει μια λίστα
με τις διεργασίες (processes) που τρέχουν στο σύστημά μας:

$ ps

PID TTY TIME CMD

2476 pts/3 00: 00: 00 bash

8034 pts/3 00: 00: 00 ps

Η τιμή της μεταβλητής $ είναι το PID της τρέχουσας διεργασίας,
όπως φαίνεται από την εντολή:

$ echo $$

2476

Η τιμή της μεταβλητής ! είναι το PID της τελευταίας διεργασίας
που εκτελέστηκε στο παρασκήνιο:

$ xterm & <- - στο background

[1] 3000 <- - jobid=1, pid=3000

$ echo $!

3000

$ jobs

[1] + Running xterm &

$ kill $!

$ jobs

[1] + Exit 15 xterm &

Μπορείτε να συλλάβετε ένα σήμα με την εντολή

trap action signal

όπου action είναι οι εντολές που θα εκτελεστούν μόλις ληφθεί
το σήμα signal. Η εντολή αυτή πρέπει να εκτελεστεί προτού σταλεί
το σήμα, διαφορετικά αυτό δε θα επεξεργαστεί.
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Ας δούμε ένα παράδειγμα:

trap. sh

#! /bin/bash

trap ' echo HUP interrupt was received! ' HUP

trap ' echo INT interrupt was received! ' INT

trap ' echo QUIT interrupt was received! ' QUIT

trap ' echo TERM interrupt was received!

echo This process will be terminated!

exit 0' TERM

trap ' echo USR1 interrupt was received! ' USR1

trap ' echo USR2 interrupt was received! ' USR2

while true

do

echo "Current time: $(date +%T)"

sleep 60

done

Όπως είπαμε, οι εντολές trap πρέπει να εκτελεστούν στην αρχή
του προγράμματος προτού σταλεί κάποιο σήμα ώστε να μπο-
ρέσουν να το συλλάβουν.

Σημειώστε ότι το σήμα KILL δεν μπορεί να συλληφθεί/επεξεργα-
στεί.

$ chmod u+x trap. sh

$ . /trap. sh &

[1] 3165

$ Current time: 13: 37: 38

kill -HUP %1

$ Hangup

HUP interrupt was received!

Current time: 13: 38: 01

kill -USR1 %1

User defined signal 1

USR1 interrupt was received!

$ Current time: 13: 38: 07

kill -TERM %1

$ Terminated

TERM interrupt was received!

This process will be terminated!

[1] + Done . /trap. sh

Οι εντολές με έντονη γραφή είναι αυτές που στέλνουμε εμείς
(αυτές δηλ. που πληκτρολογείτε) και οι οποίες στέλνουν τα σήμα-
τα στο πρόγραμμα trap.sh. Το %1 δηλώνει το jobid 1 . Θα μπορού-
σαμε να χρησιμοποιήσουμε και το PID της διεργασίας.

Κελύφη και Υποκελύφη

Μια μεταβλητή είναι τοπική στο κέλυφος που ορίστηκε, αλλά όχι
σε άλλα κελύφη, π.χ.

$ DOCUMENTS=$HOME/Documents

$ echo $DOCUMENTS

/home/john/Documents

$ set | grep DOCUMENTS

DOCUMENTS=/home/john/Documents

$ bash
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$ echo $DOCUMENTS

$exit

Ένας ακόμα έλεγχος. Δημιουργήστε το ακόλουθο testvar.sh:

#! /bin/bash

echo HOME=$HOME

echo DOCUMENTS=$DOCUMENTS

και εκτελέστε το στο αρχικό κέλυφος που ορίσατε τη μεταβλητή
DOCUMENTS:

$ chmod u+x testvar. sh

$ echo $DOCUMENTS

/home/john/Documents

$ . /testvar. sh

HOME=/home/john

DOCUMENTS=

Γιατί συμβαίνει αυτό; Γιατί το testvar.sh εκτελείται σε διαφορετι-
κό κέλυφος, σε ένα υποκέλυφος για την ακρίβεια. Ένα υποκέλυ-
φος κληρονομεί από το πατρικό κέλυφος όλα τα ανοικτά αρχεία,
τα δικαιώματα πρόσβασης, τον τρέχοντα κατάλογο, την τιμή της
umask, τους περιορισμούς στους υπάρχοντες πόρους και τις εξα-
γόμενες μεταβλητές (δηλ. όσες έχουν γίνει export).

Πώς μπορούμε λοιπόν να κάνουμε τη μεταβλητή μας
DOCUMENTS προσβάσιμη κι από άλλα κελύφη και υποκελύφη;
Μετατρέποντάς τη σε μεταβλητή περιβάλλοντος (environment
variable) με την εντολή export:

$ export DOCUMENTS=$HOME/Documents

$ echo $DOCUMENTS

/home/john/Documents

$ env | grep DOCUMENTS

DOCUMENTS=/home/john/Documents

$ bash

$ echo $DOCUMENTS

/home/john/Documents

$ exit

$ . /testvar. sh

HOME=/home/john

DOCUMENTS=/home/john/Documents

Παρατηρήστε ότι η εντολή env εμφανίζει τις μεταβλητές περι-
βάλλοντος ενώ η set τις τοπικές μεταβλητές.

Ενσωμάτωση αρχείου συνόδου

Μπορείτε να καλέσετε ένα αρχείο συνόδου (script) από ένα άλ-
λο αρχείο συνόδου προσθέτοντας μπροστά του την τελεία:

testvar2. sh

#! /bin/bash

. testvar. sh # ή . /testvar. sh

echo Inside $0

echo HOME=$HOME

echo DOCUMENTS=$DOCUMENTS

και εκτελώντας το:

$ chmod u+x testvar2. sh

$ . /testvar2. sh

HOME=/home/john

DOCUMENTS=/home/john/Documents

Inside . /testvar2. sh

HOME=/home/john

DOCUMENTS=/home/john/Documents

Η εντολή (.) διαβάζει το εισαγώμενο script, το εξάγει και το εκτε-
λεί στην τρέχουσα διεργασία.
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Συναρτήσεις

Καθώς τα προγράμματα γινόντουσαν όλο και μεγαλύτερα, έπρε-
πε να βρεθεί ένας τρόπος να «σπάσουν» σε μικρότερα τμήματα
ώστε ο κώδικας να είναι καλύτερα διαχειρίσιμος. Έτσι, εμφανίστη-
καν οι συναρτήσεις. Μια συνάρτηση ορίζεται ως εξής:

function <name>() {

<commands>

}

ή

<function name>() {

<commands>

}

Το } πρέπει να βρίσκεται σε ξεχωριστή γραμμή ή να προηγείται ;.

Ας δούμε ένα παράδειγμα:

factorial. sh

#! /bin/bash

function factorial() {

local n=$1

fact=1

until [ $n - eq 0 ]

do

fact=` expr $fact \* $n`

n=` expr $n - 1`

done

return $fact

}

echo - n " Give number: "

read number

factorial $number

echo " $number! =$fact"

Με το παραπάνω πρόγραμμα θα χρειαστεί να θυμηθείτε κάποια
πράγματα από το 1 ο μέρος του άρθρου.

Κατ' αρχήν, οι συναρτήσεις πρέπει να δηλώνονται στην αρχή
του αρχείου συνόδου. Περνάμε ένα όρισμα σε μια συνάρτηση κα-
τά τα γνωστά:

factorial $number

και μέσα στη συνάρτηση προσπελάζουμε το όρισμα ως $1 , $2
κλπ.

Τέλος, μπορούμε να επιστρέψουμε μια τιμή επιστροφής στο
καλών (κύριο) πρόγραμμα με την εντολή return. Παρατηρήστε ότι
τόσο οι μεταβλητές της συνάρτησης όσο κι οι μεταβλητές του κα-
λούντος προγράμματος είναι καθολικές (global) δηλ. προσπελάσι-
μες παντού μέσα στο αρχείο συνόδου αφού η $fact είναι επίσης
προσπελάσιμη από το κύριο πρόγραμμα. Τοπικές μεταβλητές ορί-
ζονται με την κωδική λέξη local ή typeset. Μεταβλητές ανάγνω-
σης μόνο μπορούν να οριστούν ως typeset/local -r.

Το πρόγραμμα προσπελάζει την κατάσταση εξόδου (exit status)
της συνάρτησης με τη μεταβλητή $?. Αν δεν υπάρχει εντολή
return, τότε η τιμή της $? είναι η κατάσταση εξόδου (exit status)
της τελευταίας εντολής της συνάρτησης που εκτελέστηκε. Μπο-
ρούμε επίσης να τερματίσουμε μια συνάρτηση δίνοντας ως τελευ-
ταία εντολή της την εντολή exit μ' έναν κωδικό κατάστασης
εξόδου (π.χ. 0 για επιτυχημένη εκτέλεση).



32

TUTORIAL
$ chmod u+x factorial. sh

$ . /factorial

Give number: 5

5! =120

Είναι χρήσιμο να δημιουργήσετε αρχεία βιβλιοθηκών με συναρ-
τήσεις τις οποίες να καλείτε στα προγράμματά σας με την εντολή
(.) όπως είδαμε προηγούμενα.

Αν υπάρχουν πολλές εντολές με το ίδιο όνομα, τότε η ακολουθία
εκτέλεσης (αν δε δώσουμε απόλυτο path) στο αρχείο συνόδου
μας είναι η ακόλουθη:

1 . η συνάρτηση

2. ενσωματωμένες (built-in) εντολές

3. εντολές στο PATH

Υποκατάσταση εντολών

Όπως είδαμε στο πρόγραμμα factorial.sh,

η εκτέλεση των εντολών

fact=` expr $fact \* $n`

n=` expr $n - 1`

έγινε με τη χρήση του τελεστή ` ` , ο οποίος υποκαθιστά την αριθ-
μητική έκφραση κι αποθηκεύει το αποτέλεσμα σε μια μεταβλητή.

Όμοια θα μπορούσε να χρησιμοποιηθεί κι ο τελεστής $( ) . Π.χ.

$ echo $(date)

Sat Oct 8 21: 47: 22 CEST 2011

$ echo $(hostname)

ubuntu

$ hosts=$(cat /etc/hosts)

$ echo " $hosts"

127. 0. 0. 1 localhost. localdomain localhost

: : 1 ubuntu localhost6. localdomain6 localhost6

127. 0. 1. 1 ubuntu

$ echo $(grep $(whoami) /etc/passwd)

john: x: 1000: 1000: john, , , : /home/john: /bin/bash

$ echo $(awk - F: ' {print $1}' /etc/passwd | sort)

$ for user in $(awk - F: ' {print $1}' /etc/passwd | sort)

do

who | grep $user

done

Όπως βλέπετε, πολλές εντολές μπορούν να εμφωλιαστούν ή να
χρησιμοποιηθούν ως είσοδος σε άλλες εντολές. Αυτά είναι τα πλεο-
νεκτήματα του τελεστή $( ) έναντι της παλαιότερης σύνταξης ` ` .

Ανακατεύθυνση Εισόδου

Η εντολή

command <<label

ανακατευθύνει την είσοδο (standard input) στην εντολή μέχρις
ότου να συναντήσει την ετικέτα. Π.χ.

$ mail - s ' user list' john@ubuntu <<End

$(who)

End

echo ' Email was sent to john@ubuntu'

Η εντολή mail δέχεται είσοδο μέχρις ότου συναντήσει την ετι-
κέτα End που δηλώνει το τέλος της εισόδου.
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Η εντολή

command <<- word

επιπλέον διαγράφει στηλοθέτες στην αρχή των γραμμών εισόδου.
Η εντολή

command <</word

επιπλέον δεν εκτελεί τις μεταβλητές που διαβάζει από την είσοδο,
δηλ. η είσοδος εκλαμβάνεται σαν να συμπεριλαμβάνεται σε ' ' κι
όχι σε " ". Π.χ. αν στην είσοδο έχουμε τη μεταβλητή $HOME αυτή
θα θεωρηθεί από την εντολή ως το αλφαριθμητικό '$HOME'.

Είσοδος/Έξοδος

Μια διεργασία έχει πρόσβαση σε 1 0 το πολύ αρχεία εισόδου, τα
πρώτα 3 από τα οποία είναι τα παρακάτω:

Οι εντολές

n<&x

και

n>&x

δημιουργούν ένα αντίγραφο του περιγραφέα αρχείου n, π.χ. η
παρακάτω εντολή ανακατευθύνει το stderr στο stdout.

$ find . - name " *. java" 2>&1

Άρα, μια διεργασία μπορεί να έχει πρόσβαση σε ακόμα 7 αρχεία
με περιγραφείς 3 – 9.

Το ακόλουθο πρόγραμμα αντιγράφει το αρχείο κειμένου ει-
σόδου στο αρχείο εξόδου διαβάζοντας μια-μια γραμμή:

copy. sh

#! /bin/bash

if (( $# < 2 ))

then

echo "Usage: $0 <source file> <destination file>" >&2

exit 1

fi

source=$1

dest=$2

exec 3< $source

exec 4> $dest

while read - u3 line

do

echo " $line" >&4

done

exec 3<&- 4>&-

echo File copied.

Η εντολή >&2 ανακατευθύνει το stdin στο stderr. Είναι ίδια με
την 1 >&2.
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Η εντολή exec ανοίγει τον περιγραφέα αρχείου για επεξεργασία

(ανάγνωση ή εγγραφή). Η εντολή read -u3 διαβάζει από τον περι-
γραφέα αρχείου 3 ενώ η εντολή >&4 ανακατευθύνει την εγγραφή
στον περιγραφέα αρχείου 4. Η τελευταία εντολή exec, τέλος, κλεί-
νει τους περιγραφείς αρχείων.

Αλληλεπίδραση με το χρήστη

Θα έχετε προσέξει ότι διάφορες εντολές του Linux περιέχουν
κάποιες επιλογές (options) , π.χ.

$ ls - al

Τα -al είναι επιλογές της εντολής ls. Η εντολή getopts μας βοη-
θάει να επεξεργαζόμαστε αυτές τις επιλογές στα προγράμματά
μας.

getopts optionsList optionVar

π.χ.

while getopts optionsList optionVar

do

case $optionVar in

. . .

esac

done

optionsList είναι μια λίστα με τις έγκυρες επιλογές ενώ η
optionVar είναι μια μεταβλητή που περιέχει την επόμενη απ' αυτές
κάθε φορά που καλείται η getopts. Για μια μη έγκυρη επιλογή, η
optionVar έχει την τιμή ?.

Ας δούμε ένα παράδειγμα:

options. sh:

#! /bin/bash

optionsList=' al'

a_option=false

l_option=false

while getopts $optionsList option

do

case $option in

' a' ) a_option=true ; ;

' l' ) l_option=true ; ;

esac

done

[[ $a_option = true ] ] && echo ' - a option passed'

[ [ $l_option = true ] ] && echo ' - l option passed'

και ας το εκτελέσουμε:

$ chmod u+x options. sh

$ . /options. sh

$ . /options. sh - a

- a option passed

$ . /options. sh - al

- a option passed

- l option passed

$ . /options. sh - a - l

- a option passed

- l option passed

$ . /options. sh - alv

. /options. sh: illegal option - - v

- a option passed

- l option passed
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Παρατηρήστε ότι το πρόγραμμα δεν μπερδεύεται αν περάσετε

τις επιλογές ως -al ή ως -a -l ενώ εμφανίζει ένα μήνυμα λάθους αν
περάσετε άγνωστη επιλογή. Αν δε θέλετε να εμφανίζει μήνυμα
λάθους τότε βάζετε το : μπροστά από την optionsList, π.χ.

optionsList=' : al'

. . .

case $option in

' a' ) a_option=true ; ;

' l' ) l_option=true ; ;

' ?' ) echo " Illegal option $OPTARG" >&2

esac

Έτσι, αντί για το εξ' ορισμού μήνυμα λάθους εμφανίζεται το δικό
σας:

$ . /options. sh - avl

Illegal option - v

- a option passed

- l option passed

Η μεταβλητή OPTARG περιέχει την εσφαλμένη επιλογή (όπως
είπαμε η optionsList είναι μια λίστα με τις έγκυρες μόνο επιλογές).

Αν θέλετε να περάσετε ένα όρισμα σε μια επιλογή τότε προ-
σθέστε το : μετά από την επιλογή, π.χ.:

#! /bin/bash

optionsList=' : al: '

a_option=false

l_option=false

while getopts $optionsList option

do

case $option in

' a' ) a_option=true ; ;

' l' ) l_option=true

l_argument=$OPTARG ; ;

' ?' ) echo " Illegal option - $OPTARG" >&2

esac

done

[[ $a_option = true ] ] && echo ' - a option passed'

[ [ $l_option = true ] ] && echo " - l option passed with argument
$l_argument"

οπότε:

$ . /options. sh - a - l bla

- a option passed

- l option passed with argument bla

Τέλος, τι γίνεται αν θέλετε να περάσετε και παραμέτρους στο
πρόγραμμά σας, δηλ.

$ . /options. sh - al bla Hello world!

Εύκολο θα πείτε! Ας προσθέσουμε τις παρακάτω γραμμές στο
τέλος του προγράμματος, όπως μάθαμε.

for param in " $@"

do

echo Param $param received

done

Αν εκτελέσουμε όμως το πρόγραμμα θα πάρουμε:

$ . /options. sh - al bla Hello world!

- a option passed

- l option passed with argument bla

Param - al received

Param bla received

Param Hello received

Param world! received
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Χμ! Η μεταβλητή $@ δεν μπορεί να ξεχωρίσει ποιες είναι επιλο-

γές (options) και ποιες παράμετροι. Θα πρέπει κάπως να «δια-
γράψουμε» τις επιλογές αφού τις επεξεργαστούμε, ώστε να
μπορέσουμε να επεξεργαστούμε τις παραμέτρους.

Η μεταβλητή OPTIND είναι ένας αύξων δείκτης της επόμενης επι-
λογής/παραμέτρου που επεξεργάζεται από την getopts. Η παρα-
κάτω εντολή διαγράφει τις επιλογές από τις παραμέτρους,
επιτρέποντάς μας να επεξεργαστούμε μόνο τις παραμέτρους:

shift $(( OPTIND – 1 ))

for param in " $@"

do

echo Param $param received

done

οπότε η έξοδος είναι σωστή:

$ . /options. sh - al bla Hello world!

- a option passed

- l option passed with argument bla

Param Hello received

Param world! received

Ο ακόλουθος πίνακας είναι μια περίληψη της εντολής getopts:

Μορφοποιημένη εκτύπωση

Το bash υποστηρίζει και την printf από τη C.

printf format args

όπου format είναι χαρακτήρες μορφοποίησης:

%[flagsWidth. precision] Conversion

οπου:

width: ελάχιστος αριθμός χαρακτήρων που θα εμφανιστούν·
αγνοείται αν ο αριθμός χαρακτήρων είναι μεγαλύτερος

precision: αριθμός δεκαδικών ψηφίων για πραγματικούς αριθ-
μούς / μέγιστος αριθμός χαρακτήρων για αλφαριθμητικά.

Conversion: καθορίζει πως θα εμφανιστεί το όρισμα

Π.χ.

$ printf ' Hello world! \n'

Hello world!
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$ pi=3. 14159265358979

$ printf ' pi = %6. 2f\n' $pi

pi = 3. 14

Ο ελάχιστος αριθμός χαρακτήρων (width) στο δεύτερο πα-
ράδειγμα είναι 6. Το 3.1 4 έχει όμως 4 χαρακτήρες, επομένως προ-
σθέτονται και δυο κενά στην αρχή του.

Ασκήσεις

Αν θέλετε να εντρυφήσετε περισσότερο, ορίστε και μερικές
ασκήσεις:

1 . Γράψτε ένα πρόγραμμα συνόδου που ν' αντιστρέφει
δοσμένες από το χρήστη συμβολοσειρές και να υπολογίζει τα
μήκη τους.η συμβολοσειρές και να υπολογίζει τα μήκη τους.

2. Γράψτε ένα πρόγραμμα συνόδου που να υπολογίζει το μέγι-
στο συνολικό χώρο που καταλαμβάνουν τα περιεχόμενα δο-
σμένων από το χρήστη καταλόγων.

3. Γράψτε ένα πρόγραμμα συνόδου που να τυπώνει όλα τα αρ-
χεία που βρίσκονται μέσα σε ένα δοθέντα κατάλογο.

4. Γράψτε ένα πρόγραμμα συνόδου που να μετράει τα αρχεία σε
έναν κατάλογο δοσμένο από το χρήστη.

5. Γράψτε έαν πρόγραμμα συνόδου που να ψάχνει συγκεκρι-
μένη συμβολοσειρά μέσα στα αρχεία ενός δοθέντος καταλόγου. Η
έξοδος του προγράμματος να είναι το όνομα του αρχείου και οι
γραμμές που περιέχουν τη συμβολοσειρά.

Επίλογος

Στο 2ο μέρος αυτού του άρθρου μιλήσαμε για συναρτήσεις, εντο-
λές εισόδου/εξόδου και διεργασίες ελπίζοντας να έχουμε καλύψει
το μεγαλύτερο μέρος των εντολών κελύφους με χρήσιμα παρα-
δείγματα. Π.χ. αν καταλάβατε τη διαφορά μεταξύ των:

$ echo $date

$ echo $(date)

$ echo $((date))

τότε ο χρόνος σας δεν πήγε και τόσο χαμένος! Happy scripting! :)

Πηγές:
1. CooperM. (2005), AdvancedBash-ScriptingGuide, http://tldp.org/LDP/abs/html/.

2. SoberM. (2005), A PracticalGuide to Linux® Commands, Editors, andShell

Programming, PrenticeHall.

3. MatthewN. & StonesR. (2007), Beginning LinuxProgramming, 4th Edition, Wiley.

4. Natarajan R. (2009), Linux101 Hacks,

http://www.thegeekstuff.com/2009/02/linux-101-hacks-download-free-ebook/.

5. Σημειώσειςμαθήματος“ΠρογραμματισμόςΣυστήματος”τμήματοςΠληροφορικής

πανεπιστημίουΑθηνών, 93-94.

http://tldp.org/LDP/abs/html/
http://www.thegeekstuff.com/2009/02/linux-101-hacks-download-free-ebook/
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Το Scribus είναι ένα δωρεάν πρόγραμμα ανοικτού κώδικα, για
την δημιουργία περιοδικών, φυλλαδίων, διαφημιστικών και άλ-
λων γραφιστικών εργασιών. Έχει την δυνατότητα να εξάγει αρ-
χεία σε .pdf file format, ώστε να είναι αναγνώσιμα από την
πλειονότητα των χρηστών!

Εγκατάσταση

Ανοίγουμε ένα τερματικό στον υπολογιστή μας και δίνουμε:

$ sudo apt- get install scribus

ή εγκαθιστούμε το πακέτο “scribus” από τον Synaptic ή το Ubuntu
Software Center.

Το Scribus εξάγει έγγραφα της μορφής *.sla, είδος αρχείων με
την δυνατότητα να αποθηκεύονται οι συντεταγμένες των εισα-
γόμενων αντικειμένων (κείμενα, εικόνες κ.λ.π.) . Έτσι, αν π.χ. έχου-
με προσθέσει μια εικόνα στο .sla και τη διαγράψουμε από τον
υπολογιστή μας το πρόγραμμα δεν θα μπορέσει να την εντοπίσει
αφήνοντας ένα κενό πλαίσιο στη θέση της.

Ξεκινάμε δημιουργώντας ένα κενό έγγραφο (Αρχείο > Δημιουρ-
γία). Μπορούμε να κάνουμε ρυθμίσεις για το μέγεθος της σελίδας
την διαμόρφωσή της και τη γενικότερη διαρρύθμιση του εγ-
γράφου.

Αφού δημιουργηθεί το έγγραφό μας παίρνουμε μια εικόνα σαν κι
αυτή:

Εισαγωγή στο Scribus (Μέρος 1ο) τουΜάριουΠαπαχρήστου
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Εργαλειοθήκη του Scribus

Η εργαλειοθήκη του Scibus παίζει κύριο ρόλο στη λειτουργία του. Στην
παρακάτω εικόνα φαίνονται μία-μία οι λειτουργίες της εργαλειοθήκης:

1 . Επιλογή Αντικειμένων (Select Items), μπορείτε να επιλέξετε αντικείμε-
να μέσα στο έγγραφο και να τα μετακινήσετε, να τα διαγράψετε κ.ο.κ.

2. Εισαγωγή Πλαισίου Κειμένου (Insert Text Frame), δημιουργήστε
πλαίσια κειμένου με μορφοποιημένους χαρακτήρες κ.λ.π.

3. Εισαγωγή Πλαισίου Εικόνας (Insert
Image), δημιουργήστε πλαίσια εικόνας και
αξιοποιήστε τις λειτουργίες τους

4. Εισαγωγή Πίνακα (Insert Table)
Το μόνο μειονέκτημα του προγράμματος.
Η δημιουργία πινάκων απαιτεί πολύ
χρόνο μιας και το μόνο που κάνει το
Scribus είναι να δημιουργεί όσα κελιά του
ζητήσουμε. Τα υπόλοιπα είναι δικιά μας
υπόθεση!

5. Εισαγωγή Σχημάτων (Draw Various
Shapes), δημιουργήστε διάφορα σχήματα
όπως τρίγωνα, τετράγωνα, βέλη κ.ά.

6. Εισαγωγή Πολυγώνου (Insert
Polygon), δημιουργήστε κανονικά πολύ-
γωνα (θυμηθείτε τον γεωμετρικό όρο) με
τις πλευρές τους και τις γωνίες τους ίσες.

7. Σχεδιασμός Γραμμών (Draw Lines),
δημιουργήστε ευθείες ή καμπύλες γραμ-
μές με το freehand tool (ελεύθερη σχεδία-
ση με το χέρι).
Τα υπόλοιπα στοιχεία θα εξηγηθούν σε άλλο
μάθημα.

Ιδιότητες των αντικειμένων (Object Properties)

Θεμέλιος λίθος του προγράμματος. Καθορίζει τις ιδιότητες των
αντικειμένων, οι οποίες παρέχουν την δυνατότητα δημιουργίας επαγ-
γελματικών εγγράφων.

Με τις Ιδιότητες μπορούμε να ορίσουμε τα εξής:

1 . Θέση (Συντεταγμένες) Αντικειμένων (άξονες x,y,z) και διαστάσεις
(Ύψος χ Πλάτος)

2. Αν θέλουμε να “κλειδώσουμε”
το ίδιο το αντικείμενο ή τις δια-
στάσεις του

3. Το επίπεδο (Level) του αντικει-
μένου μέσα στο έγγραφο

4. Το σχήμα του (Shape)

5. Αν είναι κείμενο ή εικόνα
έχουμε επιπλέον λειτουργίες
(Image / Text)

6. Το στυλ και το χρώμα της
γραμμής (Line)

7. Το στυλ και το χρώμα του
αντικειμένου (Colors)

Σχέσεις των αντικειμένων
(Object Attributes)

Εδώ ορίζονται οι σχέσεις μετα-
ξύ των αντικειμένων στο Scribus,
για τις οποίες θα μιλήσουμε σε
άλλο μέρος του οδηγού.
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Δημιουργήστε το πρώτο σας έγγραφο στο Scribus

ΒΗΜΑ 1 ο

Σε κενό μονοσέλιδο έγγραφο σε οποιοδήποτε μέρος του εγ-
γράφου χρησιμοποιούμε το Εργαλείο Εικόνας (Insert Image) και
ακολούθως σύρουμε το ποντίκι μας δημιουργώντας ένα πλαίσιο.
Το επιλέγουμε, πατάμε δεξί κλικ, κάνουμε “Λήψη Εικόνας” (Get
Image) και επιλέγουμε την εικόνα που θέλουμε.

ΒΗΜΑ 2ο

Επιλέγουμε την Εισαγωγή Πλαισίου Κειμένου (Insert Text
Frame) και πάλι σύρουμε το ποντίκι μας και δημιουργούμε το πλαί-
σιο. Κατόπιν, πατάμε δεξί κλικ και επιλέγουμε την “Επεξεργασία
Κειμένου” (Edit Text).

Γράφουμε το επιθυμητό κείμενο και το επιλέγουμε για να ορί-
σουμε Γραμματοσειρά (Font) και Μέγεθος (pt) από πάνω αριστε-
ρά. Μετά στο παράθυρο της Επεξεργασίας Κειμένου πάμε
Αρχείο>Ενημέρωση Πλαισίου Κειμένου και Έξοδος και έχουμε το
κείμενό μας έτοιμο!

ΒΗΜΑ 3ο

Δημιουργούμε με το Εργαλείο Εισαγωγής Σχημάτων, ένα ορθο-
γώνιο πλαίσιο σέρνοντας το ποντίκι μας (με το αριστερό κλικ πατη-
μένο) σε επιλεγμένη από εμάς θέση στο έγγραφο. Πατάμε δεξί
κλικ πάνω του και “Ιδιότητες” (Properties) . Πηγαίνουμε στην καρ-
τέλα “Colour” και επιλέγουμε ένα χρώμα.

ΒΗΜΑ 4ο

Αποθηκεύουμε. Πηγαίνουμε στο μενού Αρχείο > Αποθήκευση
(File > Save) και εκτελούμε όλες τις γνωστές διαδικασίες. Αυτό
ήταν!
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Scribus & Ubuntistas

Όσοι παρατήρησαν αλλαγές στη σελιδοποίηση των τευχών 1 2
και 1 3, σωστά έκαναν. Επειδή σ' αυτά τα τεύχη είχα την επιμέλεια
της σελιδοποίησης, άλλαξα το πρόγραμμα LaTeX που χρησιμο-
ποιόταν ως τότε, σε Scribus. Ως πρόγραμμα δεν έχει κάποιες ιδιαί-
τερες δυσκολίες και αξίζει να το δοκιμάσετε. Μπορείτε να
κατεβάσετε τα πηγαία αρχεία των τευχών 4, 1 3, 1 4 από την ιστοσε-
λίδα μας και να πειραματιστείτε ελεύθερα!

Γενικά, είναι απίστευτα τα πράγματα που μπορεί να κάνει
κάποιος με αυτό το πρόγραμμα!

Πηγές:
1. ScribusHomepage - http://www.scribus.net/canvas/Scribus

2. Getting Startedwith Scribus -

http://wiki.scribus.net/canvas/Get_Started_with_Scribus

3. Wikipedia “Scribus”- http://el.wikipedia.org/wiki/Scribus

4. Πηγαία αρχεία ubuntistas.gr - http://ubuntistas.ubuntu-gr.org/index.php/source

5. Video Tutorials (gr) - http://edutorials.gr/scribus-tutorials

http://www.scribus.net/canvas/Scribus
http://wiki.scribus.net/canvas/Get_Started_with_Scribus
http://el.wikipedia.org/wiki/Scribus
http://ubuntistas.ubuntu-gr.org/index.php/source
http://edutorials.gr/scribus-tutorials
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Μια εφαρμογή που μόνο από την ονομασία καταλαβαίνουμε πολ-
λά! Σκοπός της είναι να επισκευάζει το Boot. Δηλαδή όταν εγκαθι-
στούμε κάποιο νέο λειτουργικό.

Σε σύστημα που δεν περιλαμβάνει το grub (πχ. Windows), με το
Boot-Repair το Grub BootLoader επαναφέρεται και έτσι μπορείτε
ξανά να τρέχετε όποιο λειτουργικό επιθυμείτε κατά την έναρξη
του υπολογιστή σας.
Βέβαια αν συμβεί κάτι τέτοιο, επειδή δεν θα έχουμε το Ubuntu δια-
θέσιμο, θα πρέπει να το τρέξουμε σε liveUSB/CD, και από εκεί να
εγκαταστήσουμε το Βοοt- Repair. Αν ο χρήστης δεν είναι έμπειρος
καλό είναι να χρησιμοποιήσει την Συνιστώμενη Επισκευή που μπο-
ρεί να διορθώσει τα συνηθέστερα προβλήματα. (πχ. απώλεια του
DoubleBootLoader).

Φυσικά δεν είναι μια εφαρμογή που μπορούμε να “παίξουμε” μα-
ζί της, γιατί εύκολα αν είμαστε λίγο απρόσεκτοι, μπορούμε να
κάνουμε ζημιά στο bootάρισμα του υπολογιστή μας.

Οι παλιοί χρήστες, ίσως να έχουν ακούσει ότι δεν είναι αξιόπι-
στη εφαρμογή, αλλά πριν μερικούς μήνες ανανεώθηκε και στην ου-
σία ο τρόπος λειτουργίας της άλλαξε ριζικά με πολλές θετικές
βελτιώσεις. Τα προβλήματά της ήταν η έλλειψη development και
το ότι είχε μείνει στην παλιά έκδοση του Grub. Σήμερα έχει αποκτή-
σει πολλούς νέους developers και με την αναβάθμιση που έχει δε-
χτεί είναι πλήρως προσαρμοσμένη σε Grub 2.

Ακόμα, δεν είναι διαθέσιμη στο Ubuntu Software Center, αλλά

μπορούμε να προσθέσουμε το αποθετήριο της μέσω τερματικού:

Επισκευή Boot (Boot-Repair) τουΓιώργουΚαντιάνη



43

TUTORIAL
$ sudo add-apt-repository ppa:yannubuntu/boot-repair

$ sudo apt-get update

$ sudo apt-get install -y boot-repair && boot-repair

Επιπλέον, αν ποτέ αντιμετωπίσετε πρόβλημα και δεν έχετε την
δυνατότητα να μπείτε σε κανένα λειτουργικό, υπάρχει πιο εύκολος
τρόπος από το να τρέξετε το Ubuntu σε liveUSB/CD: Να κατεβάσε-
τε το liveCD της εφαρμογής που πρόσφατα δημοσιεύτηκε και να
το τρέξετε στον υπολογιστή σας. Μπορείτε να το βρείτε στο
ακόλουθο link του sourceforge.net:

http://sourceforge.net/projects/boot-repair-cd/files/

Ελπίζω ποτέ να μην αντιμετωπίσετε προβλήματα με το Grub, αλ-
λά, δυστυχώς, όλοι μας έχουμε αντιμετωπίσει, έστω και μια φορά
στον υπολογιστή μας. Καλό είναι να έχουμε υπόψιν μας, μία τόσο
χρήσιμη εφαρμογή όπως είναι το Boot-Repair.

http://sourceforge.net/projects/boot-repair-cd/files/
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τουΓιάννη Κωστάρα

Σ' αυτή τη σειρά άρθρων θα μιλήσουμε για την σουΐτα γραφείου

LibreOffice που διατίθεται με το Ubuntu. Δεν θα επεκταθούμε σε

μια αναλυτική παρουσίαση, αλλά θα δούμε μερικά χρήσιμα

εργαλεία που κάνουν τη ζωή μας πιο εύκολη.

Γενικά
Με τον όρο σουΐτα γραφείου εννοούμε μια ομάδα προγραμμάτων

που εξομοιώνουν απαραίτητες λειτουργίες στον χώρο του

γραφείου, όπως π.χ. συγγραφή επιστολών, λογιστικές πράξεις,

παρουσιάσεις σε διαφάνειες κλπ., οι οποίες παλαιότερα γινόταν

με άλλα μέσα.

Μια τυπική σουΐτα γραφείου περιλαμβάνει τουλάχιστον τα εξής

προγράμματα:

- επεξεργαστή κειμένου

- πρόγραμμα επεξεργασίας λογιστικών φύλλων

- πρόγραμμα δημιουργίας παρουσιάσεων

Επιπλέον, μια σουΐτα γραφείου μπορεί να περιλαμβάνει κι άλλα

προγράμματα, όπως:

- πρόγραμμα διαχείρισης βάσεων δεδομένων

- πρόγραμμα επεξεργασίας γραφικών

- πρόγραμμα αποστολής και λήψης ηλεκτρονικού ταχυδρομείου

- ηλεκτρονικό ημερολόγιο

- πρόγραμμα δημιουργίας δημοσιεύσεων

- πρόγραμμα δημιουργίας διαγραμμάτων

- πρόγραμμα διαχείρισης έργων

κ.ά.

Υπήρξαν και υπάρχουν πολλές σουΐτες γραφείου [1 ] με τις πιο

γνωστές να είναι οι παρακάτω:

- Microsoft Office

- OpenOffice/LibreOffice

- KOffice

- Apple iWork

- IBM Lotus Symphony

- WordPerfect Office

- Google Docs

- Microsoft Office 365

- Zoho

Η ιστορία του LibreOffice ξεκινάει πριν από το 1 999. Τότε

ονομαζόταν StarOffice και αναπτύχθηκε από τη Γερμανική εταιρία

StarDivision, προτού αγοραστεί από τη Sun Microsystems η οποια

και θα διαθέσει την έκδοση 5.2 για πρώτη φορά δωρεάν. Το 2002

εμφανίζεται η πρώτη έκδοση ανοικτού κώδικα του StarOffice, με

την ονομασία OpenOffice [2] . Μετά την εξαγορά της Sun από την

Oracle, μια ομάδα προγραμματιστών του OpenOffice, με αφορμή

την πιθανότητα διακοπής του έργου ή της επιβολής περιορισμών

σε αυτό από την Oracle, δημιούργησε στις 28 Σεπτεμβρίου 201 0,

το LibreOffice [3]

Η σουΐτα αυτή αποτέλεσε και αποτελεί εδώ και χρόνια το

αντίπαλο δέος του Microsoft Office, καθώς διατίθεται δωρεάν και

έχει την δυνατότητα να διαχειρίζεται τα αρχεία της σουΐτας MS

Office. Επιπλέον είναι διαθέσιμη για όλες τις πλατφόρμες,

Windows, Mac και Unix/Linux.

Η σουΐτα LibreOffice αποτελείται από τα παρακάτω

προγράμματα:

LibreOffice – Σουΐτα Γραφείου (Μέρος 1o)
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Εικόνα 1 Ησουΐτα LibreOffice

Πίνακας1 Σύγκριση MS-Office & LibreOffice

Μια λεπτομερής παρουσίαση όλων των προγραμμάτων της

σουΐτας θα απαιτούσε πολλά άρθρα. Αντί αυτού, ο συγγραφέας

θεωρεί ότι έχετε ήδη μια γνωριμία με το LibreOffice και θα

προσπαθήσει να παρουσιάσει κάποια πιο προχωρημένα και

χρήσιμα χαρακτηριστικά. Σ' αυτό το άρθρο θα ξεκινήσουμε με τον

επεξεργαστή κειμένου, το Writer.

Writer
Ο επεξεργαστής κειμένου είναι το πρόγραμμα που ίσως

χρησιμοποιείτε πιο συχνά για να γράψετε τα κείμενα σας, τις

επιστολές σας, τις εργασίες σας κλπ. Μοιάζει πολύ με τις

παλαιότερες εκδόσεις του MS-Word, μέχρι την έκδοση 2003.

Υποστήριξη Ελληνικών Χαρακτήρων
Όπως ίσως ήδη γνωρίζετε, το LibreOffice υποστηρίζει Ελληνικά.

Ο πιο εύκολος ίσως τρόπος να τα εγκαταστήσετε είναι ως

επέκταση (extension). Κατεβάστε την ελληνική υποστήριξη από

εδώ (http://tinyurl.com/2ba8bhd) και αποθηκεύστε τη στο δίσκο

σας. Στη συνέχεια από το LibreOffice επιλέξτε το μενού Tools >

Extension Manager > Add και επιλέξτε το αποθηκευμένο αρχείο

el_gr_v1 1 0.oxt. Πλέον μπορείτε να ενεργοποιήσετε τον

ορθογράφο κατά την πληκτρολόγηση από το μενού Tools >

Options > Language Settings > Writing Aids και στο πλαίσιο

Options επιλέγετε Check spelling as you type. Επίσης, στο μενού

Tools > Options > Language Settings > Languages μπορείτε να

ορίσετε την προεπιλεγμένη γλώσσα και τις τοπικές ρυθμίσεις

(locale) στα Ελληνικά, όπως επίσης και το νόμισμα (EUR).

Προτού αρχίσετε να πληκτρολογείτε κάποιο κείμενο, επιλέξτε

Tools > Language > For all Text > Greek. Καθώς πληκτρολογείτε,

βλέπετε τις λάθος λέξεις να υπογραμμίζονται με μια κόκκινη

κυματιστή γραμμή. Κάντε δεξί κλικ πάνω σε μια τέτοια λέξη για να

δείτε κάποιες επιλογές διόρθωσης. Αντί να κάνετε αυτή τη

δουλειά κάθε λίγο και λιγάκι, μπορείτε να την αφήσετε για το

http://extensions.services.openoffice.org/en/dictionaries
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τέλος. Επιλέξτε το μενού Tools > Spelling and Grammar. Από το

παράθυρο της παρακάτω εικόνας έχετε τις εξής επιλογές:

- να επιλέξετε τη γλώσσα (Greek στην περίπτωσή που έχετε

ελληνικό κείμενο)

- AutoCorrect αν θέλετε να κάνει τις διορθώσεις χωρίς να σας

ρωτήσει

- Ignore Once για να αγνοήσει το λάθος, αν όμως ξαναβρεί το ίδιο

λάθος παρακάτω θα το ξαναεμφανίσει

- Ignore All για να αγνοήσει πάλι το ίδιο λάθος αν το ξαναβρεί

παρακάτω

- Add για να προσθέσει τη λέξη σε κάποιο από τα λεξικά του

- Change για να αντικαταστήσει τη λέξη με κάποια από τις

προτεινόμενες αλλά θα σας ξαναρωτήσει αν την ξαναβρεί

- Change All για να αντικαταστήσει επιπλέον και τις τυχόν

επαναλήψεις της λάθος λέξης με την προτεινόμενη λέξη.

Το μενού Options σας μεταφέρει στο παράθυρο Writing Aids που

είδαμε προηγουμένως.

Εικόνα 2 Spelling andGrammar

Τέλος, αξίζει να σημειώσουμε το μενού Tools > Language >

Hyphenation. Σας προτείνει συλλαβισμό (-) κάποιων λέξεων που

δε χωράνε στην γραμμή, π.χ. σαρανταπο-δαρούσα.

Δυστυχώς, δεν βρήκα έκδοση με Ελληνικό μενού, του LibreOffice.

Μπορείτε όμως να κατεβάσετε την τελευταία έκδοση ως πακέτα

debian από εδώ (http://tinyurl.com/6v5hhld).

Παραμετροποίηση
Από το μενού Tools > Options > LibreOffice > User Data μπορείτε

να προσθέσετε τα προσωπικά σας δεδομένα (βλ. Εικόνα 3).

Εικόνα 3 UserData

Επιλέξτε Insert > Fields > Author για να προσθέσετε το όνομά σας

στο έγγραφο. Από το ίδιο μενού μπορείτε να προσθέσετε την

τρέχουσα ημερομηνία και ώρα, τον τίτλο, το όνομα του αρχείου

http://www.greeklug.gr/index.php?option=com_docman&task=cat_view&gid=47&Itemid=84&lang=el
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κλπ.

Μιας και είμαστε σ' αυτό το μενού, ας δούμε πως μπορούμε να

προσθέσουμε αριθμό σελίδας. Από το μενού Insert > Footer >

Default προσθέστε ένα υποσέλιδο στο έγγραφό σας. Στη

συνέχεια, κάντε κλικ στο υποσέλιδο και επιλέξτε Insert > Fields >

Page Number. Το Page Count είναι ο αριθμός σελίδων του

εγγράφου, τον οποίο μπορείτε να στοιχίσετε αριστερά, δεξιά ή

στο μέσο του υποσέλιδου.

Υποστήριξη πολλών τύπων εγγράφων
Ένα από τα πλεονεκτήματα του LibreOffice είναι η υποστήριξη

πολλών μορφών εγγράφων. Έτσι, μπορείτε να αποθηκεύσετε τη

δουλειά σας κατευθείαν σε .pdf χωρίς την ανάγκη κάποιου άλλου

προγράμματος, από το μενού File > Export as PDF ή από το

αντίστοιχο κουμπί της γραμμής εργαλείων.

Μπορείτε επίσης να ανοίξετε έγγραφα MS Word (.doc και .docx),

.rtf, WordPerfect (.wpd), Lotus WordPro κ.ά. Επίσης, μπορείτε με

το πάτημα ενός κουμπιού στη γραμμή εργαλείων (κουμπί Edit File)

να μετατρέψετε το αρχείο “για ανάγνωση μόνο”, ώστε να

αποφύγετε ενδεχόμενη ακούσια αλλαγή του.

Επίλογος
Στο πρώτο μέρος αυτής της σειράς άρθρων δώσαμε μια σύντομη

παρουσίαση της σουίτας LibreOffice και είδαμε κάποιες

δυνατότητες παραμετροποίησης όπως π.χ. προσθήκη υποστήριξης

Ελληνικής ορθογραφίας και σύνταξης. Στο επόμενο τεύχος θα

δούμε τα εργαλεία συνεργατικής συγγραφής εγγράφων

(collaboration tools) που προσφέρει το LibreOffice.

Πηγές:
1. Ελληνικό site, http://el.libreoffice.org/.

2. List ofOffice Suites, http://en.wikipedia.org/wiki/List_of_office_suites.

3. OpenOffice, http://en.wikipedia.org/wiki/OpenOffice.org.

4. LibreOffice, http://en.wikipedia.org/wiki/LibreOffice.

5. LibreOffice (2011), Getting Startedwith LibreOffice 3.3,

http://wiki.documentfoundation.org/images/c/c4/0100GS3-

GettingStartedLibO.pdf.

6. LibreOffice (2011), LibreOffice WriterGuide –WordProcessing with

LibreOffice 3.3, http://wiki.documentfoundation.org/images/b/ba/0200WG3-

WriterGuide.pdf.

7. Chanelle A. (2009), Beginning OpenOffice 3 From Novice to Professional,

Apress.

8. MillerR. (2005), Point& ClickOpenOffice.org!, Prentice Hall.

9. PerryE. (2011-2012), “HowTo –Libre Office Part 1-6”, FullCircle Magazine,

τεύχη 46-51.

http://el.libreoffice.org/
http://en.wikipedia.org/wiki/List_of_office_suites
http://en.wikipedia.org/wiki/OpenOffice.org
http://en.wikipedia.org/wiki/LibreOffice
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τουΓιάννη Κωστάρα

Η πολυαναμενόμενη νέα έκδοση της Java, μετά από αναμονή
μιας πενταετίας, είναι γεγονός. Σ' αυτό το άρθρο θα δούμε τι και-
νούρια χαρακτηριστικά φέρνει.

Εγκατάσταση

Για να δείτε τι έκδοση της Java τρέχετε δώστε σ' ένα κέλυφος
την εντολή:
$ java - version

java version " 1. 6. 0_23"

Αν λάβατε κάτι παρόμοιο με το παραπάνω, τότε ανοίξτε το Ubuntu
Software Center και αναζητήστε τη φράση “jdk 7” (βλ. [Εικόνα 1 ).
Εγκαταστήστε τα τρία πρώτα πακέτα.

[Εικόνα 1: Ubuntu Software Center]

$ java - version

java version " 1. 7. 0_147- icedtea"

OpenJDK Runtime Environment (IcedTea7 2. 0) (7~b147- 2. 0-

0ubuntu0. 11. 10. 1)

OpenJDK Client VM (build 21. 0- b17, mixed mode, sharing)

Η γλώσσα εγκαταστάθηκε στον κατάλογο /usr/lib/jvm.

Αν δεν άλλαξε η έκδοση σε 1 .7.0, τότε ακολουθήστε τα βήματα
της αναφοράς [1 ] (βλ. [Εικόνα 2):
$ sudo update- alternatives –- config java

[Εικόνα 2: ΕγκατεστημένεςεκδόσειςJava στο σύστημά μου]

και επιλέξτε την έκδοση 7 (επιλογή 3 στην πιο πάνω εικόνα). Αν
από την άλλη, το σύστημά σας έθεσε ως εξ ορισμού την έκδοση 7
αλλά εσείς θέλετε να συνεχίζετε να δουλεύετε με την έκδοση 6,
πάλι τη θέτετε με την παραπάνω εντολή. Επαναλάβετε τα παρα-
πάνω για τη javac:
$ sudo update- alternatives –- config javac

Η έκδοση αυτή διακρίνεται από τα ακόλουθα τέσσερα έργα:

- Project Coin (JSR-334) που αποτελεί μερικές χρήσιμες προσθή-

Java 7
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κες στη γλώσσα,

- τη νέα εντολή bytecode invokedynamic (JSR-292),

- New I/O Part 2 (JSR-203),

- και το framework fork/join.

Project Coin

Πρόκειται για μικρές (συντακτικές) βελτιώσεις/ προσθήκες στη
γλώσσα που αποστολή τους είναι να κάνουν τη δουλειά των προ-
γραμματιστών πιο εύκολη. Ας δούμε μερικές από αυτές:

- Ο τελεστής διαμάντι <> επιτρέπει να μη χρειάζεται να γράφου-
με τον τύπο της κλάσης και στα δυο μέρη της εντολής δήλωσης
ενός generic τύπου. Με άλλα λόγια, αντί να γράφουμε:
Map<String, List<String>> aMap =

new HashMap<String, List<String>>() ;

μπορούμε πλέον να γράφουμε:
Map<String, List<String>> aMap =

new HashMap<>() ;

- Βελτιωμένη διαχείριση εξαιρέσεων. Η εντολή try-with-
resources κλείνει αυτόματα κάποιον πόρο που ανοίξαμε για επε-
ξεργασία (π.χ. αρχείο, socket κλπ). Προηγούμενα, όταν χρησιμο-
ποιούσαμε στον κώδικά μας εξωτερικούς πόρους, έπρεπε να
φροντίσουμε να τους κλείσουμε ώστε να μπορούν να ξαναχρησι-
μοποιηθούν. Πλέον, αυτό γίνεται αυτόματα μ' αυτή την εντολή την
οποία θα εκτιμήσουν ιδιαίτερα ξεχασιάρηδες προγραμματιστές κι
όχι μόνο.

Ας δούμε τον παρακάτω κώδικα σε Java 6 που δημιουργεί ένα
αντίγραφο ενός αρχείου test.txt:
InputStream in = null;

try {

final File input =

new File(" test. txt" ) ;

in = new FileInputStream(input) ;

final File output =

new File(" backup. txt" ) ;

final OutputStream out =

new FileOutputStream(output) ;

try {

byte[ ] buf = new byte[4096] ;

int n;

while ((n = in. read(buf)) >= 0)

out. write(buf, 0, n) ;

} catch (IOException ioEx) {

// Handle this exception

} finally {

try {

out. close() ;

} catch (

IOException closeOutEx) {

// Suppress this exception

}

}

} catch (FileNotFoundException fnfEx) {

// Handle this exception

} catch (IOException openEx) {

// Handle this exception

} finally {

try {

if (in ! = null) in. close() ;

} catch (IOException closeInx) {

// Suppress this exception

}

}

Σύμφωνα με το Νόμο του Μέρφυ, μπορεί να συμβεί κάτι απ' τα
ακόλουθα:

1 . Ν' αποτύχει το InputStream:
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- το άνοιγμα του αρχείου test.txt

- η ανάγνωσή του

- το χωρίς λάθη κλείσιμό του

2. Ν' αποτύχει το OutputStream:

- το άνοιγμα του αρχείου backup.txt

- η εγγραφή σ' αυτό

- το χωρίς λάθη κλείσιμό του

3. Κάποιος συνδυασμός των παραπάνω.

Ας δούμε πώς μεταφράζεται ο παραπάνω κώδικας σε Java 7:
final File input =

new File(" test. txt" ) ;

final File output =

new File(" backup. txt" ) ;

try (

FileOutputStream out =

new FileOutputStream(output) ;

InputStream in =

new FileInputStream(input) ; ) {

byte[ ] buf = new byte[4096] ;

int len;

while ((len=in. read(buf))>0) {

out. write(buf, 0, len) ;

}

} catch (IOException e) {

// If file is not found

}

Όπως βλέπετε στον παραπάνω κώδικα, η εντολή

try (statements) { }

δεν απαιτεί μπλοκ finally { } για να κλείσετε τους πόρους που
ανοίξατε. Ο κώδικας αυτός κλείνει τον πόρο ακόμα και στην περί-
πτωση που συνέβη κάποια εξαίρεση.

Τα statements πρέπει να υλοποιούν το νέο interface
AutoCloseable. Το interface αυτό επεκτείνει το interface
Closeable και περιέχει μια μέθοδο close() η οποία αναλαμβάνει να
κλείσει τους ανοικτούς πόρους. Τσεκάρετε τις πηγές [4,5] για
κάποιες ενδιαφέρουσες σκέψεις γύρω απ' τη χρήση αυτού του
interface.

Ας δούμε και το παρακάτω παράδειγμα:
try (

BufferedReader br =

new BufferedReader(

new InputStreamReader(

new FileInputStream(

" nofile. txt" )))) {

String strLine;

while ((strLine = br. readLine()) ! = null) {

System. out. println(strLine) ;

}

} catch (IOException e) {

// If file is not found

e. printStackTrace() ;

}

Αν το αρχείο nofile.txt δεν υπάρχει, τότε ο παραπάνω κώδικας
θα πετάξει μια εξαίρεση java.io.FileNotFoundException και θα
κλείσει αυτόματα τον πόρο που αναφέρεται από τη μεταβλητή br.
Τι γίνεται όμως με τους πόρους που άνοιξαν οι
InputStreamReader και FileInputStream; Καθώς δεν αποθηκεύτη-
καν σε κάποια μεταβλητή θα παραμείνουν ανοικτοί! Γι' αυτό το
λόγο, ο παραπάνω κώδικας θα πρέπει να γραφτεί ως εξής για να
κλείσουν σωστά οι πόροι σε περίπτωση εξαίρεσης:
try (

FileInputStream fis =
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new FileInputStream(

" nofile. txt" ) ;

InputStreamReader isr =

new InputStreamReader(fis) ;

BufferedReader br =

new BufferedReader(isr) ; ) {

String strLine;

while ((strLine = br. readLine()) ! = null) {

System. out. println(strLine) ;

}

} catch (IOException e) {

// If file is not found

e. printStackTrace() ;

}

Η Java 7 επιτρέπει επίσης την ομαδοποίηση διαφορετικών τύ-
πων εξαιρέσεων ενός μπλοκ κώδικα, όπως π.χ.
try {

} catch (IOException | SQLException e) {

}

- Η εντολή switch έχει πλέον βελτιωθεί ώστε να μπορεί να συ-
γκρίνει και αλφαριθμητικά:

final String dayOfWeek = "Saturday" ;

String result = " " ;

switch (dayOfWeek) {

case " Sunday" :

result = "Κυριακή" ;

break;

case "Monday" :

result = "Δευτέρα" ;

break;

case "Tuesday" :

result = "Τρίτη" ;

break;

case "Wednesday" :

result = "Τετάρτη" ;

break;

case "Thursday" :

result = "Πέμπτη" ;

break;

case " Friday" :

result = "Παρασκευή" ;

break;

case " Saturday" :

result = " Σάββατο" ;

break;

default:

result = "Error: " + dayOfWeek +

" is not a day of the week" ;

break;

}

System. out. println(result) ;

Έξοδος:
> Σάββατο

- Ευκολότερη αναπαράσταση ακέραιων αριθμών. Η Java 6 υπο-
στηρίζει ξεχωριστή σύνταξη για την αναπαράσταση των ακόλου-
θων αριθμητικών βάσεων

- δεκαδικός, π.χ 1 5

- οκταδικός, π.χ. 023

- δεκαεξαδικός, π.χ. 0xAB

δεν υπάρχει όμως τρόπος αναπαράστασης ενός δυαδικού αριθ-
μού, παρά μόνον:
int x = Integer. parseInt(" 111" , 2) ;
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Η Java 7 επιτρέπει την εξής σύνταξη:
int x = 0b111; // για δυαδικούς

System. out. println(x) ;

Έξοδος:
> 7

Επίσης, ένα χαρακτηριστικό που το δανείστηκε από τη Ruby εί-
ναι η αναπαράσταση μεγάλων ακέραιων αριθμών ως εξής:
x = 123_456_789;

x = 0b001_111_000_010;

Εντολή bytecode invokedynamic

Διευκολύνει τη μεταγλώττιση δυναμικών γλωσσών προγραμμα-
τισμού σε Java bytecodes. Επιτρέπει μ' αυτόν τον τρόπο την
εκτέλεση γλωσσών όπως Ruby, Python ή Javascript από τη JVM.
Λύνει το πρόβλημα δυναμικής διανομής μεθόδων (dynamic
method dispatch) των γλωσσών αυτών. Επιτρέπει δηλ. αυτή η δια-
νομή να γίνει σε επίπεδο bytecode με δραματική βελτίωση της
απόδοσης εφαρμογών γραμμένων στις γλώσσες αυτές όταν εκτε-
λούνται από τη JVM, αφού πλέον μεταγλωττίζονται στη γλώσσα
μηχανής (bytecode) της εικονικής μηχανής (JVM).

Όπως, επομένως, η Microsoft με την πλατφόρμα .NET επιτρέπει
διαφορετικά τμήματα της ίδιας εφαρμογής να γράφονται σε δια-
φορετικές γλώσσες προγραμματισμού (π.χ. Visual Basic, C# κλπ.)
και να μεταγλωττίζονται στην ίδια χαμηλού επιπέδου γλώσσα στο
.NET, έτσι και η JVM υποστηρίζει (υποστήριζε και παλαιότερα) πο-
λυγλωσσικό προγραμματισμό (polyglot programming) επιτρέπο-
ντάς σας να μπορείτε π.χ. να γράψετε το front-end μιας
εφαρμογής σε Ruby και το back-end σε Java παντρεύοντας τις δυο
γλώσσες στην ίδια εφαρμογή η οποία θα τρέχει στην JVM.

New I/O Part 2 (ή “NIO.2”)

Το νέο ασύγχρονο Ι/Ο API ενδέχεται ν' αποβεί ιδιαίτερα χρήσιμο
σε εφαρμογές που χρειάζονται μαζική επικοινωνία Ι/Ο. Η γλώσσα
υποστηρίζει πλέον συμβολικούς συνδέσμους (symbolic links) ,
έλεγχο δικαιωμάτων αρχείου, callbacks όταν ενημερώνεται ένα
αρχείο ανεξάρτητα από το πρόγραμμα, κλπ.

Ας δούμε μερικά παραδείγματα. Ο παρακάτω κώδικας σε Java
6:
File file = new File(" test. txt" ) ;

System. out. println(" File exists() == " + file. exists()) ;

στη Java 7 μπορεί να γραφτεί ως:
import java. nio. file. *;

//. . .

Path path = FileSystems. getDefault() . getPath(" test. txt" ) ;

System. out. println(" Path exists() == " + Files. exists(path)) ;

Η κλάση java.nio.file.Files περιέχει γύρω στις 50 χρήσιμες με-
θόδους επεξεργασίας αρχείων που περιλαμβάνουν από αντιγρα-
φή/μετακίνηση αρχείων μέχρι δημιουργία συμβολικών
συνδέσμων. Επίσης, έχουμε πλέον τη δυνατότητα ν' “ακούμε” το
σύστημα αρχείων για εξωτερικές αλλαγές μέσω γεγονότων του
συστήματος αρχείων. Ας δούμε ένα παράδειγμα:
// listen to a directory

Path path = FileSystems. getDefault() . getPath(" dir" ) ;

WatchService watcher = null;

WatchKey watchKey = null;

try {

// Create a watch service from the file system

watcher = FileSystems. getDefault() . newWatchService() ;

// Tell me when a new entry is created in the directory

watchKey = path. register(watcher,

StandardWatchEventKinds. ENTRY_CREATE) ;

} catch (IOException e) {

e. printStackTrace() ;
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}

// wait to be called back

for ( ; ; ) {

// take() blocks until something happens

WatchKey key = null;

try {

key = watcher. take() ;

} catch (InterruptedException e) {

e. printStackTrace() ;

}

// see if this is what you were looking for

if (key. equals(watchKey)) {

// process each event

for (WatchEvent event : key. pollEvents()) {

// print the path created

System. out. println(path + " : new file created " +

event. context()) ;

}

}

// reset the key to continue receiving events

key. reset() ;

}

Αν τρέξετε το πρόγραμμα και δημιουργήσετε ένα αρχείο στον
κατάλογο dir τότε θα δείτε το μήνυμα:
dir: new file created bla. txt

Φυσικά, μπορείτε να ακούσετε και γι' άλλα γεγονότα πέραν του
StandardWatchEventKinds.ENTRY_CREATE όπως
StandardWatchEventKinds.ENTRY_MODIFY και
StandardWatchEventKinds.ENTRY_DELETE.

Τέλος, αφήνεται ως άσκηση για τον τολμηρό αναγνώστη να τρο-
ποποιήσει το πρόγραμμα ώστε να εκτελείται ο ατέρμων βρόγχος
σε διαφορετικό νήμα.

Εντολή fork/join

Η νέα αυτή εντολή επιτρέπει τη βέλτιστη χρησιμοποίηση των
σύγχρονων πολυπύρηνων επεξεργαστών. Σας επιτρέπει να
“σπάτε” ένα πρόβλημα σε μικρά αναδρομικά τμήματα προς επε-
ξεργασία από διαφορετικούς επεξεργαστές αναλαμβάνοντας όλες
τις λεπτομέρειες πολυεπεξεργασίας (concurrency) για πάρτη σας.
Είναι ιδανική για προβλήματα που μπορούν να διασπαστούν σε μι-
κρότερα, δηλ. τύπου divide and conquer. Ας δούμε ένα παράδειγ-
μα πολυπρογραμματισμού με τη Java 7, το γνωστό πρόβλημα
υπολογισμού των αριθμών Fibonacci:
private static long fibonacci(int n) {

long fib = 0;

if (n < 0)

System. err. println(" error! - - input must be a positive

integer" ) ;

else if (n < 2)

f = n;

else

f =

fibonacci(n- 1) + fibonacci(n- 2) ;

return fib;

}

public static void main(String[ ] args) {

final int n = 45;

long startTime = System. currentTimeMillis() ;

long fibo = fibonacci(n) ;

long endTime = System. currentTimeMillis() ;

System. out. println(" F(" + n +" )=" + fibo) ;

System. out. println(" Processing took " + (endTime - startTime) +

" milliseconds. " ) ;

}

Φυσικά υπάρχει μια πιο γρήγορη μη αναδρομική λύση του προ-
βλήματος, αλλά μπορούμε να δούμε πώς μπορούμε να σπάσουμε
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το παραπάνω πρόβλημα με τη fork/join.

Κατ' αρχήν πρέπει να δημιουργήσουμε ένα RecursiveTask ή
RecursiveAction (και τα δυο επεκτείνουν μια νέα κλάση
ForkJoinTask) που να περιγράφουν το πρόβλημα που έχουμε να
επιλύσουμε. Επειδή θέλουμε να επιστρέψουμε κάποιο αποτέλε-
σμα, επιλέγουμε την RecursiveTask:
class Fibonacci extends RecursiveTask<Long> {

private final int n;

private long fib;

private static final int THRESHOLD = 10;

Fibonacci(final int n) {

this. n = n;

}

@Override

public Long compute() {

// easy problem, don' t bother with parallelism

if (n <= THRESHOLD)

return fibonacci(n) ;

Fibonacci f1 =

new Fibonacci(n - 1) ;

f1. fork() ;

Fibonacci f2 =

new Fibonacci(n – 2) ;

fib = f2. compute() + f1. join() ;

return fib;

}

private long fibonacci(int n) {

long f = 0;

if (n < 0)

System. err. println(" error! - - input must be a positive

integer" ) ;

else if (n < 2)

f = n;

else

f =

fibonacci(n- 1) + fibonacci(n- 2) ;

return f;

}

long getFib() {

return fib;

}

}

Στην compute() , αν το πρόβλημα είναι τετριμμένο, κάνουμε τον
υπολογισμό απευθείας (θα 'ναι γρηγορότερος έτσι) , διαφορετικά
σπάμε το πρόβλημα σε δυο προβλήματα (υπολογισμό των n-1 και
n-2) και καλούμε τη fork() για το ένα και στη συνέχεια κάνουμε το
αποτέλεσμα join() με το άλλο.

Καλούμε τα παραπάνω με χρήση της ForkJoinPool:
ForkJoinPool pool =

new ForkJoinPool(processors) ;

pool. invoke(new Fibonacci(n)) ;

όπως φαίνεται παρακάτω:
public static void main(String[ ] args) {

final int n = 46;

// Check the number of available processors

int processors = Runtime. getRuntime() . availableProcessors() ;

System. out. println(" No of processors: " + processors) ;

ForkJoinPool pool = new ForkJoinPool(processors) ;

Fibonacci fibonacci = new Fibonacci(n) ;

long startTime = System. currentTimeMillis() ;

pool. invoke(fibonacci) ;

long endTime = System. currentTimeMillis() ;

System. out. println(" F(" + n +" )=" +fibonacci. getFib()) ;
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System. out. println(" Processing took " + (endTime - startTime)

+

" milliseconds. " ) ;

}

Ας δούμε μερικά αποτελέσματα:
Single threaded output:

F(46)=1836311903

Processing took 38128 milliseconds.

Fork/join output:

No of processors: 2

F(46)=1836311903

Processing took 31436 milliseconds.

Υπάρχει κι ένας γρήγορος αλγόριθμος fibonacci:

- f2n=2fn-1 fn + f2n, αν ο n είναι ζυγός

- f2n-1 =f2n-1 + f2n, αν ο n είναι μονός

private static long fibonacci(int n) {

long fib = 0;

if (n < 0)

System. err. println(" error! - - input must be a positive

integer" ) ;

else if (n < 2)

fib = n;

else if (n % 2 == 0) {

// F(2N) = 2F(N- 1)*F(N) + F(N)*F(N)

long fn = fibonacci(n / 2) ;

fib=2*fn*fibonacci(n/2- 1)+fn*fn;

} else {

// F(2N- 1) = F(N)*F(N) + F(N- 1)*F(N- 1)

long fn = fibonacci((n- 1)/2) ;

long fn_1 = fibonacci((n+1)/2) ;

fib = fn*fn + fn_1*fn_1;

}

}

Το αποτέλεσμα εντυπωσιακό:
F(46)=1836311903

Processing took 0 milliseconds.

Αντικαταστήστε τη στην έκδοση με fork/join και θα πάρετε το
αποτέλεσμα:
Fork/join output (fast fibonacci) :

No of processors: 2

F(46)=1836311903

Processing took 7197 milliseconds.

Αν και αργότερη από την απλή αναδρομική έκδοση (γιατί;) , είναι
σημαντικά πιο γρήγορη από την έκδοση fork/join με τον παραδο-
σιακό αλγόριθμο.

Καθώς πλέον θα μπείτε στον πειρασμό να λάβετε αποτελέσματα
για μεγάλους ακεραίους, θα δείτε ότι ο τύπος δεδομένων long δεν
είναι αρκετά μεγάλος και θα πέσετε σε υπερχείλιση. Σ' αυτήν την
περίπτωση θα πρέπει ν' αλλάξετε τα προγράμματα ώστε να δου-
λεύουν με BigInteger αντί για long, αλλά αυτό αφήνεται σαν άσκη-
ση στον αναγνώστη.

Java 8

Πολλά από τα νέα χαρακτηριστικά που προορίζονταν για την έκ-
δοση 7 τελικά θα πρέπει να περιμένουμε μέχρι την έκδοση 8 για
να τα δούμε:

- λ-λογισμό (δηλ. closures) για πιο συνοπτικό κώδικα και καλύτε-
ρη χρήση των σύγχρονων πολυ-πύρηνων επεξεργαστών

- Μικρές βελτιώσεις (ό,τι δεν υλοποιήθηκε στην έκδοση 7 από το
“Project Coin”) . Π.χ. θα μπορείτε να γράψετε: list.sort() .

- Ένα νέο σύστημα πακεταρίσματος (“Project Jigsaw”) που θ'
απλοποιήσει τη δημιουργία, πακετάρισμα και εγκατάσταση των
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εφαρμογών (δηλ. δε θα βασίζεται πλέον στους φακέλους του Λ.Σ.
όπως είναι σήμερα τα packages με τους γνωστούς περιορισμούς)

- Βελτιώσεις στο χρόνο εκκίνησης της JVM και άλλες εργονομι-
κές βελτιώσεις

Σίγουρα, η νέα έκδοση θα 'ρθει πολύ πιο σύντομα απ' ότι η έκδο-
ση 7, καθώς δεν προβλέπεται άλλη συγχώνευση εταιριών!

ΟΠΕ

Ήδη οι τελευταίες εκδόσεις των πιο γνωστών Ολοκληρωμένων
Περιβαλλόντων Εργασίας (Integrated Development
Environments) υποστηρίζουν τα νέα χαρακτηριστικά της γλώσσας.
Σ' αυτά περιλαμβάνονται το NetBeans 7, το Intelli j Idea 1 0.5 και το
Eclipse Indigo 3.7. Αν επομένως επιθυμείτε να δοκιμάσετε τα παρα-
πάνω, κατεβάστε κάποιο από τα προαναφερθέντα ΟΠΕ και δοκι-
μάστε τα! Στη συνέχεια περιγράφουμε την υποστήριξη της Java 7
από το Intelli j Idea 1 1 .

Το Intelli j Idea ήταν ίσως το πρώτο ΟΠΕ που υποστήριξε
Refactorings. Μπροστά από την εποχή του, ακόμα και σήμερα προ-
σφέρει πολλές καινοτομίες που το βοηθούν να ξεχωρίζει από το
δύσκολο ανταγωνισμό. Ευρωπαϊκό προϊόν, κατασκευασμένο στην
Τσεχία, προσφέρεται πλέον σε δυο εκδόσεις, την Community, που
είναι δωρεάν και ανοικτού κώδικα, και την εμπορική Ultimate. Η
CE αρκεί για τις περιπέτειές μας με τη Java 7 σ' αυτό το άρθρο, αλ-
λά αν θέλετε να πειραματιστείτε με πολυγλωσσικό προγραμματι-
σμό (polyglot programming) θα χρειαστείτε την Ultimate Edition
(UE).

Κατεβάστε την CE για Linux από εδώ:
http://www.jetbrains.com/idea/download/index.html και αποσυ-
μπιέστε το αρχείο
idea-1 1 .0.tar.gz:
$ tar xfz idea- 11. 0. tar. gz

$ cd bin

$ . /idea. sh

Αφού ανοίξετε το πρόγραμμα, σετάρετε το JDK 7 από το μενού
File > Project Structure > SDKs πατώντας στο κουμπί + (Add New
SDK) > JSDK και ορίζοντας τη διαδρομή του JDK 7. Στη συνέχεια,
κάντε κλικ στο Project και επιλέξτε JDK 7 για τα έργα που δη-
μιουργείτε. Επίσης, ορίστε Project Language Level: 7.0.

Είστε έτοιμοι. Δημιουργήστε ένα νέο έργο, αν δεν το 'χετε κάνει
ήδη, ελέγξτε ή ορίστε το επίπεδο γλώσσας να είναι 7 και δοκι-
μάστε τα κομμάτια κώδικα του άρθρου. Happy coding!

[Εικόνα 3: Ρύθμιση JDK7στο Intellij IDEA 11]

Επίλογος

Σ' αυτό το άρθρο μιλήσαμε για μερικές απ' τις κυριότερες αλλα-
γές που εισήλθαν στη Java 7. Καίτοι πολλές απ' αυτές δεν είναι συ-
ναρπαστικές, θα σας βοηθήσουν να γράψετε πιο συνοπτικό και
χωρίς λάθη κώδικα. Επίσης, είδαμε ποια χαρακτηριστικά να περι-

http://www.jetbrains.com/idea/download/index.html 
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μένουμε από την έκδοση 8. Αφήσαμε κάποια χαρακτηριστικά
όπως το νέο Sockets Direct Protocol για streaming μέσω
InfiniBand στο Solaris.

Μην καθυστερείτε. Αν δεν έχετε λόγους να μείνετε στην έκδοση
6 ή σε κάποια άλλη προηγούμενη έκδοση, κατεβάστε την έκδοση
7 και δοκιμάστε τη με το Idea ή κάποιο άλλο ΟΠΕ.
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